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1. Uvod

V 90-tych rokoch 20. storoCia zacali pocitace intenzivnejSie prenikat aj do bezného
Zivota. Vypoctova technika sa stala dostupnejSou, ¢o spdsobilo v mnohych odvetviach
hospodarstva obrovské zmeny.

Informacné a komunika¢né technolégie vSak prenikli aj do domacnosti a stali sa
sucastou nasho Zivota. Internet spristupnil kazdému obrovské mnozstvo informécii. Svet sa
zrazu zmensil, ludia si omnoho intenzivnejSie za€ali vymienat skdsenosti a nadzory, za¢alo
dochéadzat' k revoluénym zmenam v komunikacii, vynorili sa nové spoloCenské Standardy,
vznikali nové zavislosti. Mnoho veci sa zmenilo.

Nikto by nemal ostat bokom, bez zaujmu o tieto zmeny. Je velmi dblezité zvysit
intenzitu vzdelavania v tejto oblasti. Obzvlast sa to tyka ucitelov, ktori maju na starosti
délezita ulohu — odovzdat svoje vedomosti mladej generacii.

Ulohou tejto prirucky je pomdct ucitefom rozsirit si znalosti z vyuzivania IK
technoldgii. Verime, Ze zrucnosti, ktoré takto nadobudnud, budd méct dalej vyuzit pri
skvalitfiovani vyu€ovania.

2. Definicia odbornych vyrazov

elektronické vzdelavanie - vzdelavaci proces vyuzivajuci informacné a komunikaéné (IK)
technolbgie

elektronicky test — test spracovany do elektronickej podoby tak, aby sa dal pouZzit
v pocitaci

Uloha — zakladna zloZka testu, kazdy test pozostava s viacerych uloh; v jednom teste mézu
byt Ulohy iba jedného typu alebo Ulohy dvoch a viacerych typov

tloha dichotomickd — obsahuje dve odpovede, pri€om iba jedna odpoved je spravna
Uloha prira d’ovacia — obsahuje dve skupiny pojmov, ktoré treba navzajom spravne priradit
Uloha s kratkou odpove dou — odpovedou na tato Ulohu je vagéSinou slovo, ¢&islo, znacka,
symbol, kratke slovné spojenie a pod.

Uloha s vyberom odpovede - obsahuje viacero moZnych odpovedi, z ktorych jedna alebo
viac je spravnych

tloha usporiadacia — obsahuje slovd alebo objekty, ktoré treba usporiadat podla
zadaného kritéria

dlohy otvorené — do tychto Uloh Ziak dopifia spravnu odpoved; patria sem ulohy s kratkou
odpovedou

Ulohy uzavreté — v tychto Ulohach Ziak urCuje spravnu odpoved z ponuknutych moznosti;
patria sem ulohy dichotomické, priradovacie, s vyberom odpovede, usporiadacie

vzdeladvaci modul — multimedialna prezentacia, v ktorej je spracovana urcita ¢ast uciva,;
moZe obsahovat text, grafiku, fotografie, zvuky, video, testové ulohy, vyhodnotenie

3. Elektronické vzdelavanie

Ak chapeme informacné a komunikacné technolégie ako prostriedky na prenos
alebo uchovéavanie informéacii, tak elektronické vzdeldvanie mbézeme zadefinovat ako
vzdeldvanie pomocou tychto prostriedkov.

IK technolégie zahffiaju velmi Siroky okruh elektronickych zariadeni — patria sem
pocitace (desktop, notebook, netbook, PDA — ,osobny digitalny asistent®), tlaiarne
a kopirovacie zariadenia, skenery (zariadenia na optické snimanie dokumentov), tablety
(zariadenia na digitalizaciu pohybu pera po podlozke), obrazovky, digitdlne fotoaparéaty
a kamery, DVD a CD prehravace a ,napafovacky”, obrazové projektory, televizory, faxy,
mobilné telefony, paméatové zariadenia (CD, DVD, USB paméate, harddisky), ale taktiez
softvér, t.j. programové vybavenie IK technologii, ktoré umozrniuje spracovavat informécie
v digitalnej podobe.
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Informaéné a komunikacné technoldgie na zaliatku 21. storo€ia prinasSaju noveé
spbsoby uchovavania a prenosu inform@cii, ale kvalitativne tu nejde o prilis velky skok
oproti napr. knihdm, rozhlasu alebo televizii. V kone¢nom dbésledku sa tu vZdy iba zobrazuje
nejaky text, obraz alebo zvuk.

Co je v3ak Uplne nové, to si mozZnosti, ktoré sa otvaraju pre vzdelavanie, hlavne o
sa tyka ziskavania obrovského mnozstva informacii. Najma vyuZitie internetu prindSa uplne
nové moznosti. UCitel mbZe siahnut do neprebernej studnice vedomosti, vybrat’ si vietko
potrebné avelmi rychlo to pondknut Ziakovi. Ziak zase ziskava udivo v zaujimavej
a atraktivnej podobe. TaktieZ sa mdze aktivnejSie zu&astriovat' nielen na prijimani novych
poznatkov, ale dokonca na vytvarani samotného vyucovacieho procesu.

Samozrejme, Ze elektronické vzdelavanie asi nikdy nebude plnoautomatizovaneé,
pretoZe spolupraca medzi Ziakom a ucitefom je nenahraditelna. Zatial iba ¢lovek — ucitel vie
adekvétne reagovat na Ziakove poZziadavky a potreby. Netreba zabudat ani na spoloensky
rozmer vzdelavania, ked ucitel Ziaka nielen uci, ale aj vychovava.

V elektronickom vzdelavani sa pouZivajd hmotné prostriedky (pocitag, kamera,
tlaCiaren, atd.) a taktieZ nehmotné prostriedky (softvér). D4 sa povedat, Ze iba s vyuzitim
vSetkych prostriedkov vznikne kvalitny vzdelavaci program, Gloha alebo kurz.

Elektronické vzdelavanie m6ze mat viacero variant:

- ucitel je v priamom kontakte so Ziakom, ¢i uz v jednej miestnosti alebo pomocou kamery
a mikrofénu s prenosom cez siet

- Ziak sa zucastriuje kurzu, ktory je umiestneny na sieti, pricom s ucitefom komunikuje
prostrednictvom elektronickej posty

- Ziak rieSi ulohy samostatne na pocitaci a tieto Ulohy su automaticky vyhodnocované a
podobne

V €om spocivaju hlavné vyhody elektronického vzdelavania? Z pohladu Ziaka je to
vacsia atraktivita spracovaného uciva, moznost priamo sa zapojit do tvorby vzdelavacich
programov, pristupnost vzdeladvacich kurzov (ak sU na internete), taktieZz je tu moZnost
zvolit si tempo vyuCovania (pri praci doma), moznost wvratit sa podla  potreby
k preberanému ucivu.

Pre ucitela prind3a elektronické vzdelavanie vacésiu slobodu pri tvorbe kurzov a uloh,
moznost diferencovat vytvarané ulohy podla potrieb jednotlivych Ziakov a v neposlednom
rade je to moznost automaticky spracovat rieSenia uloh. Velmi déleZitou vyhodou je taktiez
vymena skusenosti medzi jednotlivymi ucitelmi a takisto zdiefanie vytvorenych vzdelavacich
programov.

Hlavnou nevyhodou elektronického vzdeladvania su pociatoéné vysSie naklady na
zabezpecenie hmotnych aj nehmotnych prostriedkov.

VyS&Sia financna naro€nost pri zavadzani elektronického vzdelavania je velkou, ale
nie neprekonatelnou prekdzkou pri vaésom vyuzivani takéhoto spésobu vyucovania.
Daldim déleZitym faktorom, ktory spomaluje cely proces, je tieZ nedostato&na pripravenost
ucitelov. Mnohokrat stava, Ze Ziak ma vacsie znalosti z vyuZzivania IK technologii ako ucitel.

DélezZité je, aby sa vSetky prekazky postupne odstranovali. Peniaze sa daju zohnat,
technika sa d& nakupit, ale predsudky a nechut sa prekonavaju tazko. Jedinou moznostou
ako zdolat tieto uskalia, je Uzka spolupraca ucitelov, rodi€ov a Statnych organov. Kazdému
by malo zalezat na kvalithom vzdelavani deti, pretozZe tie budu tvorit budicnost tohto Statu.

4. Elektronické vzdelavanie a zakladné Skoly

Koncom devatdesiatych rokov 20. storolia sa Skoly zacali masivne vybavovat
vypoctovou technikou a pripojenim na internet. Zaroven sa zacal klast vacsi déraz na
pocitacové zru€nosti ucitelov a vyuZivanie IK technoldgii na vyu€ovani. Mnohi ucitelia
absolvovali r6zne Skolenia, na 3kolach vznikli Specializované pocitaCové ucebne, vSetky
Skoly by mali mat pripojenie na internet. Z hfadiska dostupnosti modernych technoldgii sa
situcia na zakladnych Skolach vyrazne zlepsila.
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Ako je to vSak s pouzivanim IK technoldgii priamo na vyuCovani? Podla naSich
prieskumov situacia nie je moc priazniva. Oslovili sme 280 nahodne vybranych z&kladnych
Skél v mestach aj na dedinach na celom Uzemi Slovenska. VacSinou sme kontaktovali
riaditela Skoly. Spytali sme sa, ¢i by mali zaujem vyskusat si jednoduchy vzdelavaci softvér
uréeny pre v3etkych ziakov a zahffiajlci ucivo vietkych hlavnych predmetov ZS. Softvér bol
pristupny cez internet a od vedenia Skoly sme chceli iba to, aby o tejto moznosti informovali
ucitelov aj Ziakov.

Vysledok prieskumu bol nasledovny - 76 % 3kdl ponuku odmietlo, 24 % Skdl ponuku
prijalo.

Hlavné dévody nezaujmu boli takéto - nedostatok vySkolenych pracovnikov,
nezaujem ucitelov o IK technologie, mélo pocitacov.

Z prieskumu vyplynulo, Ze velkou prekdzkou pri zavadzani elektronického
vzdelavania na zakladnych Skolach je nezaujem ucitefov pouzivat IK technol6gie priamo na
vyudovani, ale aj v doméacej priprave. Casto uvadzanym dévodom bol nedostatok po&itacov
a tazkosti v pristupe ku Skolskym pocitatom. Obidva tieto dévody tvorili 90 % vSetkych
odmietnuti.

Analyzou vysledkov prieskumu pre prisli k tymto zaverom:
- vSetky Skoly su vybavené pocitaémi a pristupom na internet
- pocet pocitacov na Skolach je z pohladu ucitelov nedostatoény
- S8kolské pocitaCe sa vacsinou pouzivaju iba na pristup na internet
- podlfa mnohych uditefov sa IK technoldgie maju pouzivat hlavne na Informatike, na inych
predmetoch je to zbyto¢né, alebo si to nevedia predstavit
- existuje velka skupina ucitefov, ktori nevedia pouZivat IK technolégie a ani to nejavia
zaujem
- gj ti uditelia, ktori sa zaujimaju o elektronické vzdeldvanie, maju nedostato¢né vedomosti
0 vyuZiti pocitacov na vyucovani
- ucitefom chybaju zru€nosti a prax pri pouZzivani IK technolégii
- vedenie Skoly ma zaujem, aby sa pouZzivalo elektronické vzdeldvanie, ale nevie o tom
presvedcit ucitelov

5. Prinos elektronického vzdelavania pre zakladné §  koly

Dnes sa Casto proklamativne hovori 0 modernej vedomostnej spolo¢nosti. Niekedy
sa mbéze tento velmi pouzivany pojem javit ako bezobsazna fraza, ale je jasné, Ze
vyuzivanie a rozSirovanie modernych technolégii v hospodérstve aj v beznom Zivote fudi sa
neda zastavit. Ide len o to, ¢i dokadZzeme nastupit do rozbiehajuceho vlaku, alebo ¢i sme
odsudeni na to, aby sme s [Gtostou pozerali na jeho miznice zadné svetla.

Ak chceme zmenit’ tuto spolo¢nost, musime sa zamerat v prvom rade na najmladSiu
generéciu. Mladi fudia su najviac pristupni novym myslienkam. Zacat' treba uz od prvych
ro¢nikov zakladnej 3koly. Neobstoji nazor, Ze deti dobehni zameSkané vedomosti
a zruc€nosti na strednej Skole, pripadne aZz na vysokej Skole.

Dolezitym faktorom je sp6sob pouZzivania IK technoldgii na vyu€ovani. Treba dbat
o to, aby sa Ziaci nezameriavali na Uzku oblast vyuZivania pocitacov, napr. pouZivanie
internetu, ale aby ziskali prehlad aj o Specializovanom softvéri. S ¢im vacsim mnoZzstvom
softvéru sa Ziaci zoznamia, tym lahSie dok&zu v buducnosti zvliadat aj naro¢nejSie ulohy.
Elektronické vzdelavanie by sa teda malo stat prostriedkom, aby Ziaci ziskali eSte
kvalitnejSie a hlavne moderné vzdelanie, ¢o im da vacSiu Sancu uplatnit sa v tvrdej
konkurencii na trhu préace.

Vzdeldvanie pomocou IK technoldgii méze byt velmi efektivhe a zéroven aj
zabavné. Tento moderny spbsob vyuCovania v3ak kladie velké naroky na ucitelov.
Sukromné spolo¢nosti aich zamestnanci boli omnoho skdr konfrontovani s potrebou
vzdelavat sa aj v oblasti vyuzitia IK technoldgii. Z tohto pohladu je najma z&kladné Skolstvo
stale v akomsi skleniku, ktory brani realnemu pohfadu na tdto problematiku. Sklo tohto
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ochranného sklenika v3ak zacina povaZzlivo praskat, a nie je daleko doba, Ze ochranny Stit
zmizne a Skoly budu postavené pred tvrda skuto€nost — bud sa velmi rychlo prispdsobia
poZiadavkam trhu prace, alebo dbéjde na nich k velkému personalnemu zemetraseniu
a mozno aj k zaniku. Preto je velmi dblezité, aby v3etky Skoly zacali okamzite a urychlene
zavadzat elektronické vzdelavanie.
Hlavné vyhody vyuZivanie IK techniky na Skolach:
- ulah&enie vzdelavacieho procesu
- vacSia atraktivita vyu€ovania pre Ziakov
- moznost zapojenia Ziakov priamo do vytvarania u¢ebnych celkov
- urychlenie a zlepSenie kontroly vysledkov Ziakov
- zlepSenie informovanosti rodi€ov aj verejnosti o Urovni vzdelavania na Skole
- vacSia konkurencieschopnost na trhu vzdelavania
- pozitivny tlak na celoZivotné vzdelavanie ucitelov
Hlavné prekazky pri zavadzani elektronického vzdelavania:
- nedostato¢na pripravenost ucitefov
- vysokeé finanéné néklady na obstaranie IK technologii
- byrokratické poZiadavky zo strany Uradov

VSetky prekazky na ceste k modernej Skole sa daju prekonat' len postupnymi krokmi
vo vsetkych problematickych oblastiach. Nepom6Zze nakup drahej techniky, ked ju nikto
nebude vediet pouZit. Je tazké Skolit ulitelov ako vyuZivat pocita€, ked sa k nemu na
Skole ani nedostanu. Je takmer nemozné zmenit myslenie skeptikov a pesimistov zo dfia
na den.

Pri prekonavani tychto prekdzok ma nezastupitefné miesto vedenie Skoly. Riaditel
a zastupcovia maju za ulohu sledovat trendy, hfadat rieSenia a nasmerovat ostatnych
kolegov spravnym smerom. Niekedy treba byt aj tvrdy a nedstupny, pretoze mnohi ucitelia
sa iba tazko vzdavaju svojich vychodenych kolaji. InA moZnost vSak nie je. Skola musi
vyuzit kazdu prilezitost na to, aby sa postupne pribliZila k cielu — k maximalnemu vyuZzitiu
IK technoldgii vo vyu€ovacom procese. Tento ciel sa vSak zaroven stava aj branou, ktora
otvori ziakom a ucitefom nové netuSené dimenzie.

6. Elektronické testy

V predchadzajucich kapitolach sme hovorili vSeobecne o elektronickom vzdelavani.
Teraz by sme si mali struéne rozobrat jeho délezitu ¢ast, a tou je preskiSavanie ziskanych
vedomosti najméa formou testov.

Samotné preskuSavanie vedomosti u Ziaka by istothe malo prebiehat minimalne
v tychto formach:

- Ustne skuSanie
- pisomné skdSanie (spracovanie zadanej témy)
- skdSanie prostrednictvom testov

Ucitel by sa nemal vyhybat ani jednej forme. Nechame bokom prvé dva spdsoby
a zameriame sa na treti.

Testy m6zu velmi efektivne pomoct zistit Uroven vedomosti u Ziaka. Pri vytvarani
vlastnych testov sa ucitel mbdZze fahSie zamerat na presne stanovené ucebné celky, méze
testy prispdsobit tempu vyu€ovania a taktieZ ich prispdsobit osobnostnym potrebam Ziakov.
TaktieZ mb6Ze ucitel rychlejSie reagovat na pripadné zmeny vo vzdelavacom procese.

Pri vyu€ovani je velmi déleZzité urlit mieru ziskanych vedomosti. Kontrola vysledkov
je dolezitd nielen pre ucitel, ale aj pre Ziaka. UCitel na zaklade kontroly upravuje
a prispésobuje vyu€ovanie, Ziak zase ziskava spatnu vazbu a pozitivnu motivaciu. Beruc do
Gvahy tieto skuto€nosti sa test, ktory je zamerany na Uzku oblast uciva, javi ako idealny
prostriedok kontroly. Spravne zostaveny test pomdéze ucitefovi zistit' nielen to, ¢o Ziak vie,
pripadne nevie, ale aj mieru jeho znalosti.
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Délezitym faktorom pri zvazovani, &i testy pouzivat’ alebo nie, je otazka objektivheho
hodnotenia Ziakov. Pri astnom alebo pisomnom skuSani ma na hodnotenie Ziaka vplyv
nielen meratelna Uroven jeho znalosti, ale aj subjektivne faktory. U Ziaka to je jeho povaha,
motorické schopnosti, osobnostné postoje, ale aj schopnosti v oblasti spoznavania.
U ulitela je to zase miera oCakavani voCi konkrétnemu Ziakovi, ale taktiez ucitelov
osobnostny profil. Samozrejme, Ze schopny ucitel vie vSetky subjektivne faktory
minimalizovat atym dosiahnut ¢€o najobjektivnejSie hodnotenie. Istotne v3ak kazdé
hodnotenie bude do istej miery aj subjektivne. Pouzivanim spravne vypracovanych testov
sa subjektivita v hodnoteni eSte viac potlaci.

Test je velmi vhodnym prostriedkom na zistovanie vedomosti Ziaka iba vtedy, ak je
spravne vypracovany, vhodne pouZity av neposlednej rade aj spravne vyhodnoteny
(Marian Lapitka, 1996).

Testy mdZzeme delit do r6znych skupin podfa toho, na ¢o su zamerané alebo ¢o
chceme nimi zistit. Spomenieme a popiSeme iba niektoré skupiny testov, a to hlavne tie,
ktoré sa daju najlepSie pouzit na zakladnych Skolach. Tieto skupiny sa navzajom
prekryvajd, to znamena, Ze konkrétny test méze patrit do viacerych skupin.

V prvom rade s0 to testy na zistovanie Urovne vedomosti. Tieto testy su
najCastejSie, pomocou nich sa u Ziaka urCuje miera nadobudnutych znalosti z ur€itého,
presne vymedzeného okruhu uciva.

Niekedy je potrebné zistit u Ziaka rychlost, ktorou je schopny vykonavat nejaku
¢innost, napr. Citanie. V tomto pripade sa pouZivaju testy rychlosti.

Dalsim kritériom pri rozdeleni testov méze byt velkost skupiny Ziakov, ktory rieSia
konkrétny test. M6Zzu to byt triedne testy, ro¢nikové testy na Skole, ale taktiez napr.
celostatne testy. Ulohou tychto testov je porovnat vedomosti Ziaka s ostatnymi Zziakmi
v skupine a tym urcit jeho zaradenia do vykonnostnej skupiny.

Z pohladu ¢asového harmonogramu Skolského roka, m6zeme testy rozdelit na
vstupné (zistuju sa vedomosti Ziaka na zaciatku vyuCovacieho procesu v konkrétnom
Skolskom roku), priebezné (vedomosti po prebrati urlitej témy z uciva) a koncorocné
(vedomosti po uplynuti Skolského roka).

Ak zoberieme do U(vahy obsah testov, tak by sme ich mohli rozdelit na
monotematické (zahffaju jeden ucebny celok) alebo polytematické (zahffiaju viac u¢ebnych
celkov).

Z hladiska hodnotenia mézeme testy delit na tie, ktoré sa daju vyhodnotit’ objektivne
(obsahuju iba alohy, pri ktorych sa da presne urcit, ¢i boli vyrieSené spravne alebo nie) a na
testy, ktoré sa hodnotia subjektivne (obsahuja dlohy, v ktorych Ziak uvadza rozsiahlejSiu
odpoved).

V testoch sa vyskytuju rézne typy testovych uloh. V prvom rade ich méZeme rozdelit
do dvoch velkych skupin:

- Ulohy otvorené (s kratkou odpovedou, s rozsiahlejSou odpovedou)
- Ulohy uzavreté (s vyberom odpovede, dichotomicke, priradovacie, usporiadacie)

Struc¢ne si popiSeme hlavne tie Ulohy, ktoré sa daju najlepSie vyuZzit v elektronickom
vzdelavani. Podstatnym kritériom je hlavne moznost automatického spracovania
a vyhodnotenia vysledkov.

a) Uloha s kratkou odpove dou

V tejto Ulohe mé& Ziak vacSinou uviest jedno slovo, symbol, znaku a podobne.
Pomocou takejto Ulohy sa da pomerne presne zistit miera vedomosti, pretoZze odpoved je
tazké uhadnut. Je doblezité presne zadefinovat Ulohu, aby odpoved bola jednoznacna.
V opacnom pripade moéZze sice Ziak odpovedat spravne, ale nie podfa predstav ucitela.

b) Uloha s vyberom odpovede

Ziak vybera z viacerych moznych odpovedi. Ulohu s vyberom odpovede je mozné
spracovat viacerymi spOsobmi v zavislosti od poctu spravnych alebo nespravnych
odpovedi:

- Ziak ma oznadit jedina spravnu odpoved
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- Ziak ma oznadit viacero spravnych odpovedi
- Ziak ma oznacit jednu najpresnejSia odpoved
- Ziak ma oznadit jednu nespravnu odpoved

Odporucany pocet odpovedi je 4 — 6. MenSi pocCet odpovedi ako Styri zvySuje
pravdepodobnost nahodného uhadnutia spravnej odpovede. Kazda odpoved by mala byt
pritaZliva a pravdepodobnd, aby Ziak nemohol na rieSenie prist logickou Gvahou.

c) Uloha dichotomickéa

Je to v podstate Uloha s vyberom odpovede, priCom Ziak vybera z dvoch moznosti.
Vacsinou sa urCuje spravnost alebo nespravnost nejakého vyroku, to znamena, Ze
odpovede su vo forme ano/nie alebo spravne/nespravne.

Tieto uUlohy sa velmi lahko navrhuja, ale ich nevyhodou je, Ze je tu vysoka
pravdepodobnost ndhodného uh&dnutia spravnej odpovede. Preto treba tento typ Ulohy
vzdy kombinovat’ s ostatnymi typmi Gloh.

d) Uloha prira d'ovacia

Priradovacia Uloha obsahuje dve skupiny pojmov. Ziak ma pojem z prvej skupiny
priradit ku konkrétnemu pojmu z druhej skupiny.

Tato Uloha dobre preveri Ziakove vedomosti, ale taZzSie sa navrhuje ama aj
obmedzené pouZitie — nie kazda u¢ebna téma sa dé spracovat do tejto podoby.

Pri navrhovani Ulohy treba dodrZat jedno pravidlo — po&et pojmov v pravom stipci by
mal byt vy33i ako v lavom stipci. Je to opéat kvoli tomu, aby sa zniZila pravdepodobnost
uhadnutia spravneho rieSenia.

e) Uloha usporiadacia

V tomto type Glohy sa maju usporiadat vSetky pojmy zo skupiny do urcitého poradia,
napr. Cisla od najmensieho po najvacsie. Usporiadacia Uloha sa pomerne fahko navrhuje,
ale ma tiezZ iba obmedzené pouZitie.

Pri vytvarani jednotlivych typov aloh treba dodrziavat viaceré zasady:

- Uloha by mala byt €o najpresnejSie zadefinovana, aby nemohlo dbjst k nepochopeniu zo
strany Ziaka

- délezité je pouzivat nie moc zlozité vety alebo suvetia — Ziak fahSie pochopi, ¢o sa od
neho vyZaduje

- pri ur€ovani poctu bodov za jednotlivé Ulohy treba brat do Gvahy jednak typ ulohy (napr.
dichotomicka uloha je lahSia ako uUloha s vyberom odpovede), ale tiez naro¢nost uciva
v Ulohe

- pokial to testovany okruh uciva umoZzruje, tak je vhodné pouZit v testovych tlohach rézne
grafické prvky — obrazky, fotografie, schémy — Uloha je tym padom pre Ziaka zaujimavejSia
a atraktivnejSia

Vypracovanie a pouZitie testu v elektronickom vzdelavani sa da rozdelit do
viacerych krokov:

- urCenie ciefovej skupiny Ziakov — ktory ro€nik, pripadne velkost skupiny (Cast triedy alebo
cela trieda, pripadne viac tried z toho istého ro¢nika)

- zadefinovanie Ucelu testu — napr. €i to bude vstupny test na zaciatku Skolského roka,
priebezny test a pod.

- ur€enie tematického celku z uciva, ktory chceme otestovat’

- navrh Struktdry testu — pocet a typy uloh, uréenie poradia jednotlivych typov Uloh

- navrh hodnotenia — priradenie konkrétneho poctu bodov k jednotlivym Gloham

- vytvorenie testu — samotné spracovanie testu do elektronickej podoby (vloZenie textov,
grafiky, usporiadanie otazok, atd’.)

- uloZenie hotového testu do pocitaca alebo na internetova stranku

- vyrieSenie testu konkrétnym Ziakom

- vyhodnotenie — spracovanie vysledkov testov jednotlivych Ziakov, ale aj celej skupiny

- pouzitie znalosti z vyhodnotenia testu v dalSom vyu€ovacom procese — ucitel zisti, ktoré
problémy Ziaci zvladli, pripadne k ¢omu sa treba eSte vréatit

Tu treba spomenut jednu dbélezitl vec. Vytvoreny test sa da v zasade pouZzit dvoma
zakladnymi spésobmi:

10
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- priamo na vyucovani
- v ramci domacej pripravy Ziaka

Vyhodou elektronického testu je, Ze program vysledky automaticky vyhodnoti. Tym
padom ucitel uSetri vela Casu, ktory by inak musel obetovat na vyhodnocovanie
domaécej pripravy na vyucovanie. Ziak test vyriesi a hned si moze pozriet vyhodnotenie
a takisto spravne aj nespravne odpovede. Takisto rodi¢ ziska lepSi prehlad o Urovni
vedomosti svojho dietata.

Vyhody elektronickych testov:
- multimedialne spracovanie a z toho vyplyvajica vySSia atraktivita pre Ziakov
- moznost’ automatického spracovania vysledkov
- Ziak si mbze pozriet spravne aj nespravne odpovede aj samostatne
- lahka prenosnost — test sa da lahko umiestnit’ do pocitaca, na CD alebo na internet
- test sa da pouzit velakrat
- v pripade potreby sa test d& lahko upravit

Nevyhody elektronickych testov:
- test sa da rieSit iba na pocitaci — vysSie naroky na technické zabezpecenie

7. Vzdelavacie moduly

Pod vzdelavacim modulov chapeme v naSej prirucke multimedialnu prezentacia
obsahujucu vzdelavaciu Cast a testovaciu €ast. V uzSom chapani méze byt vzdelavacim
modulom aj prezentécia, v ktorej sa vysvetli ur€ity okruh uciva, ale takisto len elektronicky
test, ktory Ziakovi umoZzni skontrolovat si spravne aj nespravne odpovede.

V prezentécii méze byt pouZity text, obrdzky, fotografie, zvuky aj video. Pomocou
tychto prvkov ucitel' vysvetli ur€ité ucivo. ldeédlne je vybrat pomerne Gzku tematicku oblast),
v ktorej sa na prikladoch vysvetlia zakladné pojmy, uvedu sa definicie a pristupnou formou
sa Ziakovi objasni problematika vybranej oblasti.

Vzdeldvaci modul s grafickymi a multimedialnymi prvkami je pre Ziakov zaujimavy
a atraktivny. Nehovoriac o tom, Ze spravne spracovany modul ulah&i Ziakovi pochopenie aj
ZloZitejSieho uciva.

Elektronicky test, ktory je su€astou modulu, kde sa nachadza aj prezentacia,
preskuSa Ziaka z nadobudnutych vedomosti zo vzdelavacej Casti.

Test vSak takisto mb6ze tvorit jedinu su€ast vzdelavacieho modulu. V tomto pripade
moZu byt v teste Ulohy napr. z iného vzdelavacieho modulu, z Ustneho vykladu uditela, i
niektorej kapitoly uCebnice.

Z hladiska Struktary mdZzeme vzdeldvaci modul prirovnat ku klasickému filmu.
Spolo&né maju to, Ze aj film aj nas vzdelavaci modul maju istt dasova dizku a pozostavajl
zo z&berov. Zaber vo filme by sme si mohli zadefinovat, ako ¢ast filmu medzi dvoma
strihmi.

Vo vzdelavacom module budeme zaber nazyvat snimkou. Snimka ma urcitl velkost
a mdze obsahovat okrem zakladnych prvkov modulu (text, grafika, zvuk, video) aj ovladacie
prvky, napr. tlacidla, ktoré umoZznia prezentaciu zastavit, umozZnia preskocit na ina snimku,
spustit vioZené video alebo zvuk, skryt alebo zobrazit’ text a podobne. Snimky sa uloZzené
za sebou, mézu sa pocas vytvarania modulu vkladat, kopirovat, vymazavat a navzdjom
premiestiovat. Kazda snimka moZe mat ind dasovi dizku.

Proces vytvorenia vzdelavacieho modulu sa skladd zviacerych na seba
naviazanych Casti. Kazda z nich je dblezitd a nemali sme podcenit jej pripravu a realizaciu.

a) Uréenie témy a cie Fovej skupiny

Najskor treba vymedzit tematicky okruh uciva aro€nik, pre ktory sa vzdelavaci
modul bude vytvarat.

b) Priprava scenara

Tak ako vo filme, aj vo vzdeldvacom module je zakladnym kamernom dobre
vypracovany scenar. V scenari sa urCi pocet, poradie, ¢asové intervaly, obsah a vzhlad
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v3etkych snimok. NajlepSie je vytvorit’ si Struktirovany scenar, napr. v dokumente programu
Microsoft Word si vytvorte dva stipce — v favom stipci budl nazvy snimok, poradie, asové
intervaly a v pravom stipci bude podrobny popis kaZdej snimky. Takisto v3ak posliZi aj
obyc€ajny papier, na ktorom si velmi rychlo nacrtnete zakladnu Struktdru modulu.

¢) Zhromazdenie obsahu

Dalsim délezitym krokom je vyhladanie a zhromaZdenie celého obsahu modulu.
Treba napisat texty, pripravit si a upravit’ fotografie, obrazky, zvuky alebo filmy. NajlepSie
bude, ked si v pocitai vytvorite osobitné prieCinky pre kazdy vzdelavaci modul. Tento
prie¢inok mdze mat rovnaké meno ako vzdelavaci modul a uloZte si tam vSetky prvky, ktoré
pouZijete v module, ale takisto aj poznamky, Studijné texty a pod.

d) Naprogramovanie vzdelavacieho modulu

Po zhromazdeni obsahu modulu nasleduje samotné vytvorenie — naprogramovanie
modulu. MdZete si zvolit jeden z dvoch zakladnych spdsobov:
- snimky moZete vkladat po jednej a hned ich aj napifat obsahom
- najskor si vytvorite stanoveny pocet prazdnych snimok a potom do jednotlivych snimok
vloZite prvky po kategoriach, t.j. najprv v3etky texty, potom vSetky fotky, vSetky vided atd.

Nezabudnite vytvorit Gvodnud snimku, kde bude nazov modulu, autor, navod na
ovlddanie a podobne. Ak si vytvorite jednu takdto Uvodnd snimku, tak do dalSich modulov
ju uz mozete kopirovat a vzdy iba zmenite nazov alebo podkladovu farbu.

e) OdskuSanie hotového modulu

Po vytvoreni modulu ho treba dobre odskusat. Skontrolujte, €i sa vSetko spravne
zobrazuje, ¢i vSetko funguje, &i vtestoch nie su chyby, Ci je text bez gramatickych chyb.
NajlepSie bude, ak date hotovy vzdeldvaci modul na posudenie jednému alebo dvom
kolegom. Verte, Ze aj ked' si modul prezriete viackrét, tak iny ¢lovek tam eSte vzdy méze
ndjst chybu.

f) Zverejnenie vzdeldvacieho modulu

A potom nasleduje uZ iba zverejnenie — modul mdZete spristupnit Ziakom na
Skolskych pocitaCoch, mézete ho napalit na CD alebo umiestnit na vzdelavaci portal na
internete.

g) Diskusia 0 module so Ziakmi

Bolo by dobré, aby ste sa aj vasich Ziakov spytali, aky maju nazor na hotovy modul —
¢o sa im tam paci, o sa im nepadi, o by zmenili, vioZili alebo vypustili. Ziacke pripomienky
mbzete neskdr pouzit pri vytvarani eSte lepSich vzdeldvacich modulov.
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8. Obsah priloZzeného CD

Na CD nosi¢i sa nachadzaju multimedialne prezentacie, ktoré vas oboznamia
s najdolezitejSimi funkciami programu Adobe Captivate. CD a tlatena priru¢ka tvoria jeden
celok, pricom nosi¢ sa zameriava na nazorné vysvetlenie funkcii a priru¢ka zase popisuje
nastavenia a vlastnosti objektov, funkcie tlacidiel a pod.

Na tomto CD su tieZz niektoré uzitocné programy, ktoré moézZete vyuZit pri tvorbe
vzdelavacich modulov. Programy su volne Siritefné a vac¢sinou v ¢eskom alebo slovenskom
jazyku.

Multimedialne prezentacie su interaktivne — daju sa zastavit, znova pustit, vratit na
zaCiatok.

V animéciach je simulovany pohyb mysi, takZze nazorne uvidite, o treba robit.
Jednotlivé prezentacie sU usporiadané v prieCinkoch. Kazdu prezentaciu (animaciu)
spustite tak, Ze dvakrét rychlo kliknete na ndzov konkrétnej prezentacie (nazov neobsahuje
diakritiku a méa priponu *.exe).

8.1. Popis prie éinkov na CD

01-Uvitacia obrazovka
- 01-Vytvorenie prazdneho projektu - Blank Project
- 02-Otvorenie projektu zo zoznamu - Open Recent
- 03-Otvorenie projektu - Open Recent-Open
02-Zobrazenia
- 01-Zobrazenia
- 02-Edit View
03-File
- 01-Novy projekt - New
- 02-Otvorenie projektu - Open
- 03-Otvorenie projektu zo zoznamu - Open Recent
- 04-Ulozenie projektu - Save
- 05-Ulozenie suboru pod inym nazvom - Save as
- 06-Import
- 07-Export
- 08-Informacie o dokumente - Document Info
- 09-Nahlad - Preview
- 10-Publikovanie projektu do formatu flash - Publish - Flash
- 11-Publikovanie projektu do programu - Publish - Media
04-Edit
- 01-Upravy - Edit
- 02-Upravy-Nastavenia - Edit-Preferences
05-Insert - Other Slide(s)
- 01-Uloha s vyberom odpovede 1 - Multiple Choice 1
- 02-Uloha s vyberom odpovede 2 - Multiple choice 2
- 03-Uloha s vyberom odpovede 3 - Hot Spot
- 04-Dichotomicka uloha - True-False
- 05-Uloha so strucnou odpovedou 1 - Fill-in-the-blank 1
- 06-Uloha so strucnou odpovedou 2 - Fill-in-the-blank 2
- 07-Uloha so strucnou odpovedou 3 - Fill-in-the-blank 3
- 08-Uloha so strucnou odpovedou 4 - Fill-in-the-blank 4
- 09-Uloha so strucnou odpovedou 5 - Short answer
- 10-Priradovacia uloha - Matching
- 11-Usporiadavacia uloha - Sequence
06-Insert - Standard Objects
- 01-Textovy blok - Text Caption
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- 02-Oznacovaci ramcek - Highlight Box
- 03-Rolovaci blok - Rollover Caption
- 04-Rolovaci obrazok - Rollover Image
- 05-Rolovacia snimka - Rollover Slidelet
- 06-Zvacsovacia zona - Zoom Area
- 07-Textove pole na vstup - Text Entry Box
- 08-Klikacia zona - Click Box
- 09-Tlacidlo - Button
07-Insert - Drawing Objects
- 01-Ciara - Line
- 02-Stvoruholnik - Rectangle
- 03-Elipsa, kruh - Oval
- 04-Viacuholnik - Polygon
08-Insert — Ostatné
- 01-Vlozenie prazdnej snimky - Blank Slide
- 02-Animovany text - Text Animation
- 03-Obrazok - Image
- 04-Flash Video
09-Slide
- Snimka - Slide
10-Project
- Skin Editor
11-Window
- Okno - Window
12-Snimka - Upravy a vlastnosti
- 01-Snimka-vlastnosti - Slide properties
- 02-Nazov snimky - Slide-Label
- 03-Pozadie snimky - Slide-Background
- 04-Snimka-upravy - Slide-Copy, Paste, Delete
- 05-Casova os snhimky - Timeline for Slide
13-Kopirovanie objektov
- Kopirovanie objektov - Copy, Paste
UZito €né programy
- CCleaner - udrzba systému pocitaa
- DVD Shrink - kopirovanie DVD do pocitac¢a
- Foxit Reader - prezeranie PDF
- Gimp - graficky editor - raster
- Inkscape - graficky editor - vektor
- PDF Creator - vytvaranie PDF dokumentov
- Power Point-viewer - prehliada¢ powerpointovych prezentacii
- Super — Konvertovanie videa do réznych forméatov
- XnView - spravovanie a editovanie fotografii
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8.2. Popis Uvodného okna prezentécie

01 -sovy projekt - New = I =100 |

| (3>

Zakladna Skola, TribeCska 1653/22, TopolGany

|I> Nowy projekt (stbor)

1 — hlavny nazov prezentacie (vacsinou v slovencine)

2 — vedlajSi nadzov prezentacie (v angli¢tine, zodpoveda textu v programe Adobe Captivate)
3 —tlacidlo na spustenie prezentacie

4 — ovladacie tlacidlo — vratenie na zaciatok prezentacie

5 — ovladacie tlacidlo — spusti alebo zastavi prezentaciu

6 — ovladacie tlacidlo — posunie prezentaciu o jednu snimku smerom k zaciatku

7 — ovladacie tlacidlo - posunie prezentaciu o jednu snimku smerom ku koncu

8 — rychly posun prezentacie

9. Pracovné plocha
Na pracovnej ploche v programe Adobe Captivate su r6zne panely, tlaCidla, odkazy na
informacie a podobne. Pracovnu plochu si mézete prispésobovat — panely aj tlacidla sa
daju schovat alebo zobrazit.
9.1. Zobrazenia plochy
Pracovna plocha ma tri zakladné zobrazenia:
- Storyboard View

- Edit View
- Branching View

15
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Jednotlivé zobrazenia mdzete prepinat pomocou klavesovej skratky Ctrl+Tab (sucasne
stlaCte klaves Ctrl aklaves Tab; klaves Tab je na klavesnici vfavo nad kldvesom Caps
Lock ). Taktiez mdZete pouzit panel Workspace .

[ige ‘ gﬁnudio ‘ E

Branching View

9.1.1. Storyboard View

Toto zobrazenie sa ukaze hned na zaciatku po spusteni programu Adobe Captivate. Viavo
je panel Slide Tasks (1), kde mézete napr. urCovat kvalitu videa v oznacenej snimke,
modZete snimky kopirovat, vkladat aj vymazavat alebo menit vlastnosti ozna¢enej snimky
(snimku oznadcite tak, Ze na fu kliknete).

Na paneli Information (2) s Udaje o velkosti projektu (objavia sa az po prvom publikovani)
a rozliSenie snimok v pixeloch.

NajvacSiu Cast zaberd plocha s nahfadmi snimok (3). Snimky moZete medzi sebou
presuvat — uchopte mySou konkrétnu snimku a presunite ju na nové miesto.

Na paneli Slide notes (4) sa zobrazenia poznamky, ktoré su uloZené v oznacenej snimke.

Eilhlrl'qﬂ‘l'ﬂnlr ek i el o™ .‘.m.!ﬂ
Fis Edb Vew Dnet Sde Ao Qi Promct Window Hep Ed]

ke som & e (i fiocord | Ll Prevew = 3 Publah | il Send for Rurview T, e G Soorboard i -]

- shide Tasks A
G sudo

—) Miouss

By wen qualty

e Addionsl S,
Copry Thda 2 EY
Pt o Image -

W Delete Sida
Hicke She

E Propssrtes..

= Informsation
Alracersl wrd oernatson well B cenn
ivalable whan the project i publshed, 4 5

Aagibtare BN o 600
lei: 5

v —
Oosed Caphion ... Tk bo speech ., Ehcles ke Refisziee

: H Chck to add nobes for the selected dide 4
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9.1.2. Edit View

Zobrazenie Edit View je najCastejSie pouzivané. V strede je plocha snimky a po stranach
st r6zne panely s nastrojmi.

7] Adobe Captivate - untithed.cp - [Slide 1 of 5%

: (1 - "*”“”Za
Fle Edt Vew Sert Shde Aude Guiz Project Window Hip %
2 b s & e 5o | igmiecod | [l veview « (N Publeh [ Send For iviews T e |+ ﬂ {[Ect view -

N

G - Filmstrip X ﬂﬂnmm._ % w1y G L B Wa v =
T e
@ H ':g" l 3
of
L .:
ol
e (7
all :
A :
il u l
ﬁ .
= [ "
o 4
) f :
B s - W
24| = Tenelne for Shde 1 o
| .T‘...'.".“:".EF Ll L e T | i mr“!

DO s B
P e P P .=AJ

a o wowe F Y O=F Ao A

LE]

1 — hlavné menu s ponukami

V ramci jednotlivych ponuk su rézne polozky. Pomocou tychto poloZiek sa ovladaju vsetky
funkcie programu.

2 — panel s nastrojmi Main

Na tomto paneli su najCastejSie a najdblezitejSie nastroje.

Save — ulozZi projekt

Undo — vrati spat poslednu akciu

Redo — zopakuje poslednu akciu

Record — nahravanie obrazovky do snimok

Preview — néhlad projektu

Publish — publikovanie projektu

Audio — nahravanie zvuku

Sipka do lava, doprava — zobrazenie vedlajSej snimky

3 — panel s nastrojmi Object

Pomocou nastrojov na paneli sa do aktualnej snimky vkladaju rézne objekty, ako napr.
textovy blok, ramc&ek, tlacidlo, obrazok, video a pod.

4 — panel Workspace

SlUzi na prechod na iné zobrazenie.

5 — Filmstrip
Panel s nahfadmi snimok. Je to akoby ,filmovy pas“. Aktualna snimka je zvyraznena.
6 — Timeline
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Casova os, na ktorej sa nastavuji ¢asové intervaly jednotlivych objektov. Kazdy objekt je
symbolicky zobrazeny ako pésik s textom. Pasiky sa daju skracovat, predlZzovat’ aj posuvat
po osi. V hornej ¢asti je meradlo v sekundéach.

7 — aktuélna snimka

9.1.3. Branching View

V tomto zobrazeni vidno suavislosti medzi jednotlivymi snimkami. MéZete tu skontrolovat a
nastavit napr. skoky medzi snimkami.

| adobe Captivate -untitledee® =0l x|
Fle Fdt Ves Jromt Shie Aodo Gl Project Winde el x|
| fed e & oo 5 e econd | Previow + . bl | [ Send for e ) rota Euﬂ | [Brancting view -
¥ Properties e ok R i | — (TN |
Link
e 1 Side &

Kpavagation: | GO tonest shis -

Sidn s

* Legeml
=+ = Navipation
—r mhuccess
— = Falye
=+ = Shda franch
o] = Opee LEIL o e
3 = Send emal Clowad Caption ., Texk toospeach ., Fhde noles Rammcrm
4 = Evacube Javasingt M 3t add robers for e selected side »
EE = Opan other project

9.2. Casova os (Timeline)

Na Casovej osi su pésiky s textom, ktoré symbolizuju objekty v snimke.

Spodny pésik — Slide symbolizuje samotnu snimku.

Plati tu jedno pravidlo — objekt, ktory je na Casovej osi zobrazeny nad inymi objektmi, je nad
nimi aj v snimke. Toto vyuZijeme pri umiestiovani jednych objektov na druhé, napr . ak
treba na farebny obdiznik vioZit text. Staéi na &asovej osi mySou uchopit konkrétny pasik
a presunut ho vyssie.

Pri vkladani objektu do snimky sa tento objekt vloZi vzdy na najvrchnejSiu poziciu.

Dizka péasika vyjadruje podet sekind, pocas ktorych je objekt zobrazeny. Snimku treba
chapat ako kusok filmu. MdZete uréovat dizku tohto Gseku, a to tak, Ze prejdete mySou na
pravy koniec pasika Slide, kliknete a potiahnutim pasik prediZite. Tymto spésobom uré&ite aj
dizku zobrazenia jednotlivych objektov. Je jasné, Ze objekt mdZe mat maximalne takd dizku
zobrazenia, ako dlho sa zobrazuje snimka.

Upravou dizky jednotlivych pasikov méZete dosiahnut zaujimavé efekty, napr. postupné
objavovanie sa alebo miznutie objektov v snimke.
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1 — zobrazenie alebo skrytie objektu

Treba kliknut na malické koliesko pod okom a objekt sa schova alebo zobrazi. Tato funkcia
je vyhodna pri velkom mnoZstve objektov v snimke a pomdze nam sprehladnit pracu.
Skrytie objektov nema vplyv na vyslednu hotovi animaciu.

2 — zamknutie objektu pred nezelanymi zmenami

Takisto treba kliknut na koliesko pod zadmkom.

3 — lupa na zmenu rozliSenia meradla

4 — ovladacie tlacidla

Zastavenie a spustenie prehravania snimky, stiSenie zvuku.

9.3. Panely s nastrojmi (Toolbars)

Panely s nastrojmi obsahuju rézne nastroje na Upravu snimky alebo projektu. Jednotlivé
panely sa daju zobrazit alebo skryt.

V ponuke Window prejdite mySou na Toolbars a potom kliknite na konkrétny ndzov panelu
(tento postup zapiSeme symbolicky takto: Menu > Window > Toolbars ). Zobrazené panely
su oznacené fajockou.

[F] Adobe Captivate - untitied.cp - [Slide 3 of 5*]
1 Fle Edt WYiew Insert Side Audio Quiz Project [
l H save f Undo 9 feds | [ Recard ¥ Main A
4 == : = v Object —
i . v Timeline Cer+ak+T
. - - o
_:__* N e oo | 2" * Ubrary Cirivaiyl ¥ Advanced |
|B z U | E T = =|E Slide Motes Ctrivaltspy ¥ Drawing
= - v Filrstrip Criantan| < s
w Filmstrip % | [ siide Properties... v Alignment
» de Proper Question Poal
T — |HE Svah Bar v Text Edit
E} . T v Labels an Toolbar
| Filmstrip Stze Y
1-Menu

V Menu su ponuky s poloZzkami, pomocou ktorych sa ovladaju vietky funkcie programu
Adobe Captivate.

File (stibor) — praca so subormi — otvorenie, uloZenie publikovanie a podobne
Edit (Gpravy) — kopirovanie, vymazavanie, nastavenie vlastnosti projektu
View (pohlad) - vzhlad projektu

Insert (vlozit) — vkladanie objektov do snimok

Slide (snimka) — nastavenia snimky

Audio (zvuk) — nastavenia zvuku

Quiz (kviz) — nastavenia testovych uloh

Project (projekt) — dalSie nastavenia projektu

Window (okno) — zobrazenie a skrytie panelov

Help (pomoc) — ndvody

19



Zakladna Skola, Tribe¢ska 1653/22, 955 01 Topol¢any

tyate - wnlithed ogi - [Shede 3l 5* §

Fie Bt Wew et Shie Ao Que Prowd Wrdm Heb

Thedsw & v 90 | (ermcud | b - 3w | @ smdtoreem | Do | [ B3 || e
Ne e | daen :

7 L EEAEESERE|™ = o2& 2 | = |- W - [

i

|

| Ty x| B, (X0 S X OB A8 S8 oomfon 7]
3 - |

: B

i

01 B

H :

4

- 2

L L LT

I SR e L o e e

v YECS§Heva0uR0. 089,

t'j' Bl T T= H:h_J

.&ajﬁumélﬂiﬂcﬂéﬂ<:|

1 — Main — hlavny panel

2 — Object — vkladanie objektov

3 — Advanced - niektoré nastavenia projektu

4 — Drawing - kreslenie

5 — Workspace - prepinanie medzi zobrazeniami
6 — Alignment - zarovnavanie objektov

7 — Text Edit — Gpravy textu
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9.4. Panely (Panels)

Pomocou poloziek v paneloch sa ovladaju dalSie funkcie a vykonavaju rdézne operacie
v projekte.

1. Ponuka File > Window .

2. Kliknite na ndzov panelu (zobrazené panely maju pri ndzve fajocku).

B adobe Captivate - untitled.cp - [Slide 3 of 5]
File Edit Wiew Insert Slide audic Quiz  Project UMW Help
J E save € Undo 4 Redo ‘ [l Record Vel ' E
—_— v Timeline Chrl+alk+T
[ | T fimstrip X Slide Properties... |ibrary ChrbHAl+HL
= v Slide Motes Chrl+alt+
m v Filmstrip Chrl+Al+E
O Question Pool
1 Skatus Bar
TR
k Filmstrip Size 4
Q Design Templake  Cerl+-alt+Y
[aT Comments Chrl+Al+E
. 2 ‘Widget Chrl+al+7
:3 . - Image Edit LR AlE
M E E
=101 =
e B Ve Z frt Shds s Quz Prokct Window ek |
I Gess | igmetord | Lyl Proview = g Pubkeh (& Sendtor Ravien @ rua | | [Eme e -
;‘. - Flmstrin % || G5 cige Propemmies . | yoae Y= Znomt 66 -]I ~ Library - untitle_. X
i [ B «| Empiy Wrary
& F :
LI - : Freview not avadabie,
W . -+
E B
. ™ T
¢ | = —
= k i Ao Foldr |
- i. | Bechgrounds  Polder
|:| - }2 bmepes Folder
1P Heda Foldes
& FEE— 1] Presentabions  Folder
S F |
G [
| —
'J 1 H Cloged Caption ...\ Test to'speach ... s nokes
== : .. a Chek bo add robes for the selacted shds
L i
[. = Tiewecline fos Slide 3
Il‘l'\_u L F."Fl 3‘:.---.:f. Lusdiznb TJ Rl el 3‘ Iml 'I';”'. ?l
l\@ = b 3 000
é el W (s - i‘ﬁa L £ | _.’.I

1 - Timeline — ¢asovéa os

2 — Library — kniZnica s médiami, ktoré su v projekte

3 — Slide Notes — sem mdzete vkladat poznamky ku snimke
4 — Filmstrip — nahlad snimok
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9.5. Nastavenia projektu (Preferences)

PopiSeme si len niektoré nastavenia. Ktoré netreba menit, tak tymi sa nebudeme venovat.
Nastavenia z jedného projektu mdZete exportovat, t.j. uloZit ich do Specialneho suboru na

harddisk a potom ich nasledne importovat do iného projektu.

i
Category Global: General Settings

= E_Iuhal

=)+ Recording

zeneral Settings

efaults

- SWF Size and Quality
- Publish Settings
- Start and End

[=1- Quiz

- Reparting

- Setkings

- Pass o Fail

- Defaulk Labels
- PENS

v Show Welcome Screen

[~ Generate Project Backup

- Settings [~ Rescale Imported/Pasted Slide

- Full Motion Recording

- Keys Default locations:

- Modeis)

. Defaules Publish at: Iu::'l,Du:u:urnents and Settingsijm\Dokumenty iy
[=1- Project Browse. .. |

- Info —

Commenks ak: I

Erowse... |

Grid size; |16 =

speling preferences. ., |

Confirmation messages. .. |

Global — General Settings

Show Welcome Screen
Captivate)

Generate Project Backup — vytvaranie zalozného suboru pri ukladani

Rescale Imported/Pasted Slide — prispdsobenie velkosti vkladanej snimky

Publish at — nastavenie zakladné priecinka, kde sa budu ukladat’ publikované projekty
Comments at — nastavenie prie€inka, kde sa budu ukladat pozndmky a komentare
Grid size — nastavenie medzier medzi vodiacimi bodmi

— zobrazenie Uvodnej obrazovky (pri spusteni programu Adobe
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Cakegory

Project: Info

Preferences

= Global

é----GeneraI Settings
i Defaults

=) Recording

- Settings

- Full Maokion Recording
- Keys

- Models)

- Defaulks

=l Project

- SWF Size and Quality
- Publish Settings
- Start and End

[=1- Quiz

- Reporting

- Settings

- Pass of Fail

- Defaulk Labels
- PENS

Author:

Company
E-mail
Website
Copyright

Project name

Descripkion:

; Icnmpany

g Iauthur@campany.mm

3 IWWW.EDI’HDEIH‘;.".CDITI

: Icupyright

: Iuntitled

project description

Project — Info

Author — meno autora projektu
Company — spolo¢nost, firma
E-mail — e-mailova adresa autora
Website — webova stranka
Copyright — autorské prava
Project name — nézov projektu
Description — popis projektu
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%

Category Project: Skart and End
=B G!Dbal : .
eneral Settings Praject skatt options:
i Defaults v Auto Play:
[+ Recording
- Settings I _I
- Full Mation Recording ¥ Preloader:
- kEys
- Models) I _I
- Defaults Preloader %% (100 ﬁ
= P i t
= T::I::n [~ Password protect project:
- SWIF Size and Quality | |
UblISh Settings [~ Project expiry date:
B tart and End
B iz f20. 10, 2008 ¥
- Reparking
- Sattings Message line 1 IThis project has expired
- Pass or Fail
- Default Labels Message line 2! I
- PENS [ Eade in on the First slide

Project end options:

Ackion: ILUUp project j

v Fade out an the last slide

Project — Start and End

Auto Play — automatické spustenie pri otvoreni vyslednej animacie
Password protect project — ochrana vyslednej animacie heslom
Project expiry date — urCenie platnosti vyslednej animacie

Fade in on the first slide - rozjasnenie prvej snimky

Action — akcia, ktoréd sa vykona na konci animacie

Fade out on the last slide — zotmenie poslednej snimky
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5I
Category Quiz: Setkings
- G!ohal Quiz:
E----General Settings -
i Defaulks hame: IQL"Z
& Recordlr.ug Required: IOptionaI - the user can skip this quiz j
- Setkings
- Full Maotion Recarding Ohijective ID: IQuilel 11
- Keys
- Made(s) Interaction ID Prefix: I
- Defaulks
- Project Mote: Prefix characters ko the Interaction ID to maintain uniqueness
rojec when publishing For poal sharing.
- Info
S\.I\r'bllz i:ze and Quality Settings:
- Publish Settings
v Shuffle Answers
- Start and End M s
£ Quiz |w Show progress
- Reporting v allow backward movement
& -etkings :
Pass or Fail Iv Show score at end of guiz
- Diefaulk Labels | i Quiz Result Messages. .. I
- PENS
[ allow user to review quiz
Cuestion Review Messages. .. |

Quiz — Settings

Shuffle Answers — mieSanie odpovedi v tlohach pri kazdom spusteni vyslednej animécie
Show progress — zobrazovanie Cisla ulohy z celkového poctu

Allow backward movement — umozZznit spatny pohyb
Show score at end of quiz — zobrazenie vyhodnotenia na konci testu
Allow user to review quiz  — povolit uzivatefovi pozerat si rieSenie tloh
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Quiz Result Messages ]|

Message:

v £E§_§__IIIE§§_§_QEEE Congratulations, vou passed,

IV Eail message: | Sarry, vou Failed.

K 131 N K O

Ernail button text:  [Send E-mail

rScore
[ Display score

[+ Display mazimurm possible score

[¥ Display number of correct questions
[¥ Display total number of questions

[ Display accuracy (g.0., 70%)

[¥ Display number of quiz attempts

Quiz Result Messages

Pass message - text, ktory sa ukaze, ak uzivatel dosiahol potrebny pocet bodov
Fail message - text, ktory sa ukédze, ak uzivatel nedosiahol potrebny pocet bodov
Display score — zobrazit dosiahnuty pocet bodov

Display maximum possible score  — zobrazit maximalny pocet bodov, ktory sa da v teste
dosiahnut

Display number of correct questions  — zobrazit po€et spravnych odpovedi

Display total number of questions  — zobrazit celkovy pocet Uloh v teste

Display accuracy — zobrazit UspesSnost (pomer dosiahnutych bodov k celkovému poctu
bodov)

Display number of quiz attempts  — kolkokrat bol test rieSeny

x

Review feedback message

Correct: o answered khis correcthy!

Incomplete: I‘fou did nat answer this question completely:

Incorreck: IYDLII' Answer:

IThe correct answer is:

Quiz Review Messages

Correct — text, ktory sa zobrazi, pri spravne vyrieSenej tlohe
Incomplete — text, ktory sa zobrazi, pri nekompletnej Ulohe
Incorrect — text, ktory sa zobrazi pri nespravne rieSenej tlohe
Your answer — tvoja odpoved

The correct answer is — spravna odpoved je
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x

Cakegory Quiz: Pass or Fail

El- Glabal
i General Settings Pass Fail options:
- Default 5

& Recorili:: = lC IBD j % or more of kotal points to pass
- Sethings r I = inks:
. Full Mation Recarding 0 = paints or more ko pass (Total painks: 200
- KEys Mote: Maxirurn paoinks is the sum of all weighted points,
- Models)
- Diefaulks IF passing grade;

[=1- Project
- Info Action: I Continue ;I

- SWF Size and Quality
- Publish Settings
- Start and End

=+ Quiz
- Repaorting N
- Settings IF Failing grade:
r Fail Allows user: |1 j attemnpts or [ Infinite sttempts
- Defaulk Labels
-PENS ™| Show Retake Button

Ackion: I Conkinue ;I

Quiz — Pass or Fall

Pass fail options — prva volba — pocet percent, ktoré musi uzivatel dosiahnut, aby test
uspesne absolvoval, druh& volba — pocet bodov nutnych na UspesSné absolvovanie testu

x

Category Quiz: Default Labels
e Gg?F(?Lneral Settings Defaulk question button labels:
5----Defaults Subrpiit: ISLIbI'ﬂit
=1+ Recording
- Settings Clear: ICIear
- Full Motion Recording -
- Keys Skip: ISka
- Mode(s] Back: IBack
- Defaulks
=] Prajeck
- Info Defaulk question Feedback:
- SWF Size and Quality
- Publish Settings Carreck message:
- Start and End ICurrect - Click anywhere or press ' to continue
El-Quiz Incorreck message:
- Reporting
.. Settings IIncurrect - Click anywhere or press ' to continue
..Pass or Fail Retry message:
Faulk Labels ITrl:"I again

Incomplete message:

I‘f‘ou rusk answer the question before continuing

Timeouk message:

|The tirne to answer this question has expired.

Quiz — Default Labels

Submit — text na tlaCidle, ktoré potvrdzuje zadanie odpovede
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Clear — tlacidlo vycistit, vymazat

Skip - tlacidlo preskodit, ist vpred

Back — tlacidlo spat

Correct message - text, ktory sa zobrazi, ak uzivatel spravne vyrieSi tlohu
Incorrect message — text, ktory sa zobrazi, ak uzivatel nespravne vyrieSi tlohu
Retry message - vyzva na zopakovanie — ,skus to znova“

Incomplete message - text, ktory sa zobrazi, aj je Uloha nekompletna

Timeout message - text, ktory sa zobrazi po vypr3ani ¢asového limitu

10. Projekt (Project)

Pri spusteni programu Adobe Captivate sa ukédze tzv. ,uvitacia® obrazovka. Je na nej

viacero blokov a niektoré z nich si teraz stru¢ne popiSeme.

Fin Edt Vv Window Help

:
|
E

{UHE

] o | | |

« Tutesials ared Tips s Check out mmw Adolbe® ol earning
» Suppent Cenber I Suite

'|E|__ » Findd dusthorized Training Comglste tooka for stfore] roh el samng
« Frae bamplsbes and resounoes ooekenk. Inchades feey Adobe Capthests 4.
- Chech & ok,
1 ont show s

=101 %]

1 — Open Recent

V tomto bloku sa nachadzaju nazvy naposledy otvorenych projektov. Ak kliknete na

Open..., tak mbZzete v pocitaci vyhladat iny projekt, ktory nie je v zozname.
2 — Create Project

Pomocou jednotlivych poloZiek sa vytvaraju rozne druhy projektov.

3 — Getting started tutorials

V tejto Casti su r6zne inStruktazne videa.

Novy projekt mozete vytvorit aj takto:

1. Ponuka File > New > Project .
2. Otvori sa okno, v ktorom si vyberiete konkrétny druh projektu.
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10.1. Vytvorenie prdzdneho projektu (Blank Project)

Najskér urcite velkost projektu. MdZete si vybrat z predvolenych rozmerov alebo zadat
vlastné rozmery.

New Project

iR | Record | Create a project starting with a blank glide, without recording
Q From Template any slidez initially
Blank Project
@ Fram M3 PawerPaint Select Size:
) 1mage Slideshow [ 200 500 Full Screen =l
17 ] Project Template . = i =
i widh [P0} Heoht
D Design Template

&) Leam more... ok I Cancel

Select size — vyberte velkost nového projektu
Width — Sirka (v pixeloch)
Height — vyska (v pixeloch)

10.2. Vytvorenie projektu z prezentacie MS PowerPoi  nt (From MS PowerPoint)

Projekt mbzZete vytvorit aj z prezentacie MS PowerPoint. Najskor kliknite na tlacidlo Browse
a potom v pocitaci vyhladajte prezentéciu.

New Project

Create | Record |

Q From Template
Ll

EBlank Project

Create a project by importing slides from Microsoft
PaowerPaint projects

Frarm M3 PawerPaint

=
E‘-—! Image Slideshow
[ ] Project Template

D Design Template

Learn more...
o i Browse.. Cancel
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10.3. Vytvorenie projektu z fotografii (Image Slide  show)

Novy projekt mézete vytvorit aj z viacerych fotografii, ktoré mate uloZzené v pocitadi.

Vyberte velkost nového projektu (Select Size) > kliknite na tlacidlo Browse > vyhladajte
v pocitaci fotografie (mali by byt uloZzené spolu v jednom prie€inku) > oznacte fotografie >
kliknite na tlacidlo Otvori t’.

New Project

G | Record I Create a project using & number of images that you want

Q From Template displaved az a slideshow

[ Blank Project

’?‘} From M5 PowerPoint Select Size:

[F=) 1mage Slideshon [[800 600 Full Screen =

"] Project Template . - : =

= with [0+ et

':f Design Template

Learn more...

e Browse... | Cahcel |

10.4. Nahlad projektu (Preview)

Pri vytvarani projektu je potrebné Casto kontrolovat, ako bude vyzerat vysledna animacia.
Na to sluzi funkcia Preview (nahlad).

Nahlad moZete spustit' viacerymi spbsobmi:

1. Ponuka File > Preview > Play this Slide (prehrd aktualnu snimku), Project (cely
projekt), From this Slide (od aktualnej snimky), Next 5 slides (pat nasledujacich snimok
od aktuélnej).

2. Kliknite na tlacidlo Preview na paneli Main.

3. Pouzite klavesy — F3 — Play this Slide , F4 — Project , F8 — From this Slide , F10 — Next
5 slides .

[ Adabe Captivate - uniftiedep® =10 =l
el ol 7 LR GVER X, 00 prmvsen =

iimint -

8ecEcc0e
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1 - Slide x of y — ukazuje, ktora snimka z kolkych sa prave prehrava

2 — beZec na pésiku ukazuje orientacnu polohu prave prehravanej snimky voci celej
animacii

3 — Edit (upravit) — po stlacené tohto tlacidla sa otvori prave prehravana snimka

v zobrazeni Edit View

4 — Close preview (zatvorit nahlad)

5 — plocha snimky

6 — tlaCidl4 na ovladanie pohybu animécie

10.5. Publikovanie projektu (Publish)

Projekt, ktory vytvarate v programe Adobe Captivate, sa da pozerat len v tomto programe.
Aby sa dal spustit’ aj na pocitaci, kde nie je program Adobe Captivate, pripadne otvorit ha
internete, tak treba zdrojovy projekt exportovat — publikovat. Publikovanie je teda proces,
pri ktorom zo zdrojového projektu vznikne novy subor. Pri akejkolvek zmene v zdrojovom
projekte treba znova urobit nové publikovanie.

Projekt m6Zete publikovat tymito spésobmi:

1. Ponuka File > Publish .

2. Kliknite na tlacidlo Publish na paneli Main.

3. Pouzite klavesovu skratku Shift+F12 (sucasne stlacte tieto dva klavesy).

10.5.1. Publikovanie projektu — Flash (SWF)

Tento format pouZzite, ak chcete publikovany projekt umiestnit na internet.
Najskér urobte vSetky nastavenia a potom kliknite na tlacidlo Publish .

Publish x|
—Flash {.swf) option ~Praoject Information
: " Resolution: 800 x 600 pixels
Projeck Title: e
Iuntitled Slides with audio: 0
Falden Audic qualicy: MP3, 96 kbps, 44,10 KHz
Adobe ,"!i:i‘h_l_:nl i elearning output: Disabled
Connect Pro Ic:'l,Documents and Settings\jm|Dokumenty My Adobe Display score: Mo
Enable Accessibility; Yes
Iv Publish files ko a falder Browse... | Skin: skin-publikacie-ndu
PEMS: Preview, .,
Flash{SWF) size and quality: Custom
ActionScripk Yersion: 452
ioukput Cpkion:

[~ Zip files ¥ Export HTML
[ Full screen [~ | Send PENS motificatiar

!‘p\:n [ Gererate auborun for C0 [ Export PDF

FTP Flash Player Version: |Flash Player & LI

P

—

Review & Lean mare.. Publish I Close

Project Title — nazov vyslednej animécie

Folder — priecinok, kde sa animécia uloZi

Browse - vyhladat prie€inok

Publish files to a folder — publikovat subory do prie€inka

Full screen — ak zaciarknete poli¢ko, tak animacia sa bude zobrazovat na celej obrazovke
Export HTML — exportovat kod HTML

Export PDF - exportovat do PDF
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Resolution - rozliSenie v pixeloch (informacny Udaj)

Slides — podet snimok (informacény udaj)

Slides with audio — pocet snimok so zvukom (informac¢ny udaj)

Audio quality - kvalita zvuku

Skin — po kliknuti na tato poloZku sa otvori Skin Editor , kde sa nastavuju napr. okraje
alebo ovladacie tlacidla

Preferences — po kliknuti na toto tlacidlo sa otvori okno s nastaveniami projektu

10.5.2. Publikovanie projektu — Media

Pri pouziti tohto forméatu sa projekt vyexportuje bud do suboru s koncovkou *.exe (subor sa
bude dat spustit na kazdom pocitaci, kde je operany systém Windows) alebo ako film
s koncovkou *.avi.

.EXe" subor bude mat pInu interaktivitu, subor ,avi“ je film, ktory nema Ziadnu interaktivitu.

Publish x|
~Media option rProject Information
Select Type: Resolution; 800 x 600 pixels
Slides; 7
IWindows Executable (*.exe) j Slides vith audio: 0
Praject Title: Sudio quality: MP3, 96 kbps, 44,10 kKHz

elearning output; Disabled
Display score; Mo

Iuntitled

Folder: Enable Accessibility; Yes
Sking skin-publikacie-ndu
Ic:'l,Documents and SettingsijmiDokumenty il L | PENS: Preview,..

Flash{5WE) size and quality: Custom
ActionScript Yersion: ASZ

~Custom ,exe icon

| | Preferences. ., |

moutpuk Opkions:
[ Zipfiles
I Full screen

I™ Generate autorun For €O

Flash Player Wersion: |Flash Player & LI

&9 Lean more... Publish I Close

Select type — urcite typ vyslednej animacie - *.exe alebo *.avi

Project Title — nazov vyslednej animacie

Folder — prie€inok, kde sa animécia ulozi (na vyhfadanie prie€inka kliknite na tlacidlo
s troma bodkami)

Full screen — ak zaciarknete poli¢ko, tak animécia sa bude zobrazovat' na celej obrazovke
Resolution - rozliSenie v pixeloch (informacny Udaj)

Slides — podet snimok (informacny udaj)

Slides with audio — pocet snimok so zvukom (informacény udaj)

Audio quality - kvalita zvuku

Skin — po kliknuti na tdto poloZzku sa otvori Skin Editor , kde sa nastavuje napr. ram¢ek
alebo ovladacie tlacidla

Preferences — po kliknuti na toto tlacidlo sa otvori okno s nastaveniami projektu
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11. Snimka (Slide)

Snimka je zakladnym prvkom projektu. Rozmery snimky (velkost) urCuju rozliSenie hotovej
animacie, do snimky sa vkladaju v3etky objekty — text, grafika, fotografie, zvuk, video a pod.

11.1. Vlastnosti snimky (Slide Properties)
Ak chcete zmenit vlastnosti snimky, tak to m6Zete urobit viacerymi spésobmi.

1. Kliknite pravym tlacidlom mysi na plochu konkrétnej snimky v paneli Filmstrip . Otvori sa
zoznam s polozkami, v ktorom kliknite na polozku Properties .

Adobe Captivate - untitled.cp - [Slide 1 of 5]

File Edt Wiew Insert Slide Audio Quiz  Project  Wind
J H Save 4F LUndo 3 Redo g Record ‘ I_TEI
0 i v Filmstrip X | [ Siide Properties... | i

- ‘ l
.
.
0 E
. Hide Slide Shift+Ctrl4+H
O ' %) Lock Slide CErlHK
-
[}\ﬁ =, Insert 4
@l ' Copy Slide Chrl+C
' Paste as Image Chrl+y
Ja [ buplicate Slide ChrlHD
T e % Delite Slide el
Copy Background Shift+Cerl+-y
[:] Paste as Background  Shift+Cer+y
@ Select al Chrl+A
3
- Filmstrip Size 4
e}
Transition 4
£3 ) Mouse 4
L i i ]
i1 . % Video Quality
Audio 4
Praoperties. .. Shift+Ctr+D
) =
H| 15 | d

2. Ponuka Slide > Properties.

Adobe Captivate - untitled.cp - [Slide 1 of 5]

File Edit View Insert fudic Quiz Project  Windol
J H Sevm 7 Uikl Hide Slide Shift+CtrlH
'+ Lock Slide Chrl+K
i w Filmstrip Show comments
2N -
. Transition 4
m E GrouE 4
O E ) Mouse L4
41 %Video Quality 4
e ] Properties...  Shift+Cer4D
@ [H 1]
3. Pouzite klavesovu skratku Shift+Ctrl+D (sucasne stladte tieto tri klavesy).
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Otvori sa okno Slide Properties . Po vykonani vSetkych zmien nezabudnite kliknat na
tlacidlo OK.

TEE—— zl
Side | audo |
—Slide setting
Label: I
Display Time:  |3,0 jl seconds
Transition: IND Transition j
Guality:  [Low {5-bit) |

Colori  Project " Custom [+
I~ Hide slide [~ Lock slide

Change background image. .. |

Mavigation
I‘ On slide enter: I Continue ;I
|
+
0On slide exit: I G0 ko next slide ;I
Notes... | Accessibility., .. |
I~ apply ko al Settings + |
&9 Leam more... [ol’s I Caricel
Karta Slide

Label — nazov snimky (kazda snimka musi mat iny nazov)

Display time — diZka zobrazenia snimky (implicitne je nastaveny ¢as 3 s)

Transition — prechodové efekty medzi snimkami

Quiality — kvalita zobrazenia (nastavuje sa automaticky)

Color (farba) — Project — snimka bude mat taku farbu pozadia, akéa je ur€ena pre cely
projekt (nastavuje sa v Preferences > Global > Defaults > Background color); Custom -
moZzete urlit’ vlastnu farbu pozadia snimky (kliknite sa tlaCidlo vedra textu Custom)

Hide slide (skryt snimku) — ak zaciarknete toto poli¢ko, tak snimka sa neobjavi vo
vyslednej publikovanej animacii

Lock slide (zamknut snimku) — ak zaciarknete toto policko, tak sa zakadZzu akékolvek
Upravy snimky aj vSetkych objektov v snimke

Notes — po kliknuti na toto tlaCidlo mézete napisat poznadmku, ktord bude priloZzena
k snimke (poznamky k snimkam vyuZijete, ak pdjde o zlozitejSie snimky, ktoré obsahuju
mnoho objektov — m6Zete si poznalit zadmer alebo rézne vysvetlivky)
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x|
Library,.. | Edit. .. | Closed Captioning...l Delete |
0,0 jl seconds Fade aut; [0,0 j seconids
Settings. .. |

I™ Loop audio

[~ sStop background audio
[~ Apply ko &l Settings ¥ |
&) Leam more.. o Cancel

Karta Audio

Cez tuto kartu mbZete nahrat alebo vlozit zvuk do snimky.

Nahravanie (musite mat’ k pocitau pripojeny mikrofén):
- kliknite na tlac€idlo s ¢ervenym kruzkom (1)

- zastavenie nahravania (2)

- spustenie vloZzeného zvuku (3)

VlozZenie zvuku
- kliknite na tlacidlo Import (4) > vyhladajte poZzadovany zvuk v pocitaci > kliknite na tlacidlo
Otvori t

Settings — nastavenie kvality zvuku

Loop audio — zvuk sa bude prehravat stale dookola

Stop background audio — ak zaciarknete toto poli¢ko, tak zvuk na pozadi (znie pocas
prehravania animacie) sa pozastavi
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11.2. Pridavanie snimok do projektu
11.2.1. Importovanie snimok z iného projektu (Impor  t Slides)

Tdto funkciu moéZete vyuzit napr. vtedy, ak pracujete na viacerych projektoch, ktoré maju
rovnaku alebo podobnu niektora snimku. Tuto snimku staci vytvorit iba raz a do ostatnych
projektov si ju uz importujete.

Ponuka File > Import > Slides/Objects > vyhladat v poc€itaci projekt, z ktorého budete
importovat.

Otvori sa okno Import Project .

Po vykonani vietkych Gprav kliknite na tlaidlo OK.

i
Select Al '! Clear All 'l 11 of 11 slides selected to import
Slide 2 I Slide 3
Slide and objects (6] Import: lSIide and objects (4] 'i Imnpork: iSIide and objects [1) 'i
|Slide 1 i I Place objects on: |Slide'2 7. I Place objects on! |Slide 3 T l
N L . I
4 | K 4
& Leamn more... oK I Cancel |

1 — tu su zobrazené néahfady snimok, ktoré mézete importovat

2 — pomocou tohto tlacidla oznacite - vyberiete na importovanie bud snimky aj objekty
(Select All ), alebo iba snimky (Slides ), pripadne iba objekty (Objects )

3 — pomocou tohto tlacidla odznacite bud’ snimky aj objekty (Clear All'), alebo iba snimky
(Slides), pripadne iba objekty (Objects )

Import — pri konkrétnej snimke vyberte, ¢o budete importovat’

- Do not import — nebude sa importovat' ni¢

- Slide and objects — snimka aj vSetky objekty v snimke

- Slide only - iba snimka

- Objects only — iba objekty

Place objects on - tu vyberte snimku, do ktorej sa budu objekty importovat

No objects on slide - tento text znamena, Ze v konkrétnej snimke nie su Ziadne objekty

4 — poslvanie snimok
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11.2.2. Kopirovanie a vymazavanie snimok (Copy, Pas te, Duplicate, Delete Slide)

Snimky moZete kopirovat a potom vlozZit na iné miesto v dokumente.

1. Pravym tlaCidlom mysi kliknite na paneli Filmstrip na snimku, ktort chcete skopirovat >
v ponuke, ktora sa ukaze, kliknite na Copy Slide > pravym tlacidlom mysSi kliknite na
snimku, za ktoru sa skopirovana snimka vlozi > v ponuke kliknite na Paste Slide .

2. M6zete pouZit klavesové skratky — kliknat' na snimku, ktord budete kopirovat > Ctrl+C >
kliknat na snimku, za ktoru sa skopirovana snimka vlozi > Ctrl+V .

Ak kliknete na polozku Duplicate Slide (Ctrl+D), tak sa oznafena snimka zduplikuje —
»Zdvoji®.
Ak kliknete na polozku Delete Slide (Del), tak sa oznaené snimka vymaZze.

J EI SdVE v LI J FETD | Ial"u:,‘LLll'Ll | ‘-m-' FPTET
0 ¢ v Filmstrip X | [ Slide Properties... |
- il |
-
m -
-
-
-
0O : Hide Slide Shift+Ckr+H
H 1 %) Lock slide Chrl+K
-
N
& Insert 4
Q ' Copy Slide Chrl+C
[T " Paste as Image Chrl+y
2 [] Duglicate Side ChH+D
'j 7 Delete sSlide Del
[:] Copy Background Shift+Ctrl+y
Paste as Backgroond  Shifk+Chrl+Y
3| Select Al Chrl+a
3
. i D S 3
=l Filmstrip Size
. Transition 4
XS
) Mouse L4
& 4 % Yideo Quality L4
EF‘ Audio 4
™y Properties. .. Shift+Chr+D  lech
o
| ;| T

11.2.3. VloZenie prazdnej snimky (Insert blank slid  es)

Na paneli Filmstrip Kliknite na snimku, za ktord chcete prdzdnu snimku vlozZit > ponuka
Insert > Blank Slide .

11.2.4. Zmena poradia snimok

Na paneli Filmstrip Kliknite na vybrand snimku, uchopte ju (podrzte tlacidlo mysi stlacené)
a presunte ju na iné miesto.
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12. Snimky s ulohami

Ponuka Insert > Other Slide(s) > Question Slide .
Otvori sa okno Question Types , v ktorom si vyberiete typ testovej tlohy.
Nakoniec kliknite na tladidlo Graded Question .

Question Types il

Multiple choice

¥ | True/False

Fill-in-the-blank

Short answer —Description

Matchin
9 Multiple choice questions ask

users ko choose one or more
Hot Spot correck answers from a list of
possible answers,

Sequence

Rating Scale (Likert)

aLearn mare... | Graded Questian... I Survey Queskian.. . | Cancel

Multiple choice - tloha s vyberom odpovede

True/False — dichotomické& uloha (ano/nie)

Fill-in-the-blank — Gloha so stru&nou odpovedou (odpovedami)

Short answer - Gloha so stru¢nou odpovedou

Matching — priradovacia tloha

Hot spot — Uloha s vyberom odpovede (oznadovanie napr. obrazkov)
Sequence — usporiadacia uloha

Rating Scale (Likert) — zistovanie ratingu (nehodnoti sa)

Graded Question - Gloha bude zahrnuta do celkového hodnotenia testu
Survey Question - Gloha nebude zahrnuta do celkového hodnotenia testu
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12.1. Uloha s vyberom odpovede
12.1.1. Uloha s vyberom odpovede (Multiple Choice)

Ponuka Insert > Other Slide(s) > Question Slide > Multiple Choice > Graded Question .
Otvori sa okno Multiple Choice Question

Multiple Choice Question x|
Questian |gptians | reporting |

ruestion
Mame: |Mu|ti|:n|e chiice
Question: ;I
Painks: IID :Il Wiew quiz preferences. ..

CANSWET
< Select correct answer here [~ shuffle Answers

add
Type: |Single Response j Mumbering: |4, B, C... hd
& Lean more... 0K I Cancel

Karta Question

1 — do tohto pola sa vkladaji odpovede — kliknite hocikde na bielu plochu a mbéZete pisat
Name (meno) — vloZte nazov ulohy alebo nechajte prazdne

Question (otazka) — text ulohy (otazky)

Points (body) — pocet bodov, ktoré dostane uzivatel za spravne rieSenie

Answers (odpovede) — odpovede

Select correct answer here (tu oznacte spravnu odpoved) — ked vloZite vSetky odpovede,
tak spravnu odpoved vyznacte kliknutim na maly biely kraZzok

Shuffle Answe rs — ak zaCiarknete toto poli¢ko, tak pri kazdom otvoreni testu sa odpovede
premie3ajq, t.j. povymienaju si pozicie

Type — Single Response - typ ulohy — jedina spravna odpoved

Type — Multiple Responses — typ ulohy — viacero spravnych odpovedi

Numbering (Cislovanie) — vyberte typ Cislovania

Add (pridat) — odpovede mbéZete pridavat aj tak, Ze kliknete na toto tlacidlo

Delete (odstranit) — kliknite na niektord napisant odpoved a potom kliknite na toto tlacidlo —
odpoved sa odstrani

Po vykonani vSetkych aprav kliknite na tlaCidlo OK.
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Multiple Choice Question x|

Question  Cptions |Eep0rting|

—Type

Tvpe: IGraded - there are right and wrong answers j

[v Show clear butkon W Show back butten [ Show skip bukton

rIF correct answer

Ackion: Continus

[¥ Show correct message

r—If wrong answer

Allow user: 1 :ll attempts or [ Infinite attempts
Failure levels: |1 vl {errar message nak shown iF <none is selected)
Ackion: I Conkinue ;l

[¥ Show retry message W Show incomplete message [ Show time out message

& Lean more... 0K I Cancel

Karta Options

Show clear button (ukazat tlacidlo vymazat) — ak je policko zaliarknuté, tak v snimke sa
zobrazi prislusné tlacidlo

Show back button (ukézat tlaidlo spat)

Show skip button (ukazat tlacidlo preskocit)

If correct answer (ak je odpoved spravna)

Action — Continue (akcia — pokracovat)

Action — Go to previous slide (akcia — ist na nasledujucu snimku)

Action — Go to next slide (akcia — ist na predchadzajicu snimku)

Action — Jump to slide (akcia — sko€it na snimku)

Action - Open URL or file (akcia — otvorit URL alebo subor)

Action - Open other project (akcia — otvorit iny projekt)

Show correct message (ukazat hlasenie pri spravnej odpovedi)

Allow user 1 attempts or ... Infinite attempts (povolit uzivatelovi 1 pokus(y) alebo ...
nekonec¢ne vela pokusov)

Failure levels — 1 (Groven zlyhani — 1)

Failure levels — None (Uroven zlyhani — Ziadne)

error message not shown if <none> is selected (chybové hlasenie sa neukéze, ak je
vybrané <none>)

Show retry message (ukazat opakovacie hlasenie)

Show incomplete message (ukazat hladsenie pri nekompletnosti)

Show time out message (ukazat hlasenie pri vyprdani Casového limitu)

Karta Reporting

Na tejto karte sa urCuje ¢asovy limit (Time limit ) na vyrieSenie ulohy.

40



Zéakladna Skola, Tribe¢ska 1653/22, 955 01 Topol¢any

12.1.2. Uloha s vyberom odpovede (Hot Spot)

V tomto type Ulohy sa oznaduju objekty — napr. obrazky, geometrické tvary alebo ina
grafika. Spravnych odpovedi mdzZe byt aj viac.
Ponuka Insert > Other Slide(s) > Question Slide > Hot Spot > Graded Question .

Hot Spot Question 5[

Question |thi0ns | Reporting |

ueskion

Marme: IHot Spok

(V== I o ose the correct ame from the lisk of haokspats ;l
[ 7]

Paints: IID j \igw quiz preferences. .,

Hot Spoks: |3 =

Choose: IDeFauIt Animation Select... I I Allow Clicks On Hat Spats Only

€ Lean more... oK I Cancel |

Name (meno) — vloZte nazov ulohy alebo nechajte prazdne

Question (otazka) — text Ulohy (otazky)

Points (body) — pocet bodov, ktoré dostane uZivatel za spravne rieSenie

Hot Spots — tu si zvolte pocet rAmcekov ,hot spot”

Choose (vybrat) — vyberte oznaCovanie hot spotov (graficki znacku, ktord sa ukaze po
kliknuti na plochu snimky)

Select — kliknite na toto tladidlo a v zozname vyberte niektort znacku

Allov Clicks On Hot Spots Only  (kliknutie povolit len na ,hot spoty*)

Caorrect - Click
anywhere or press

Oznac spravne ......
T T 'y" to continue

Incarrect - Click
anywhere or press

'y to continue |
You must answer
the question before 4
continuing
[ ]
(2225 ¥414)
@uestion 1 of 1 Clear Back Skip Submit
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1 - rdmceky ,hot spot*

Ramcéeky sa umiestnia na nejaké objekty (napr. obrazky), ktoré vloZite do snimky
a z ktorych ma Ziak vybrat spravnu odpoved. Zelena fajoCka v ramcéeku znamend, Ze
ramcek oznacuje spravnu odpoved.

2 — hlasenie pri spravnej odpovedi

3 — hlasenie pri nespravnej odpovedi

4 — hlasenie pri nekompletnosti

5 —tla€idlo vymazat (vycistit)

6 — tlacidlo spat

7 — tlacidlo preskocit

8 — tlacidlo odoslat’ — potvrdit

9 — vtejto Casti sa po skon&eni testu ukdze hodnotenie — Ci bola Uloha spravne alebo
nespravne vyriedena

Je jasné, Ze vSetky rdmceky hot spot by nemali oznaCovat’ spravnu odpoved. Preto treba
zmenit vlastnosti niektorych rdméekov.

Kliknite pravym tlaCidlom na niektory raméek hot spot > v ponuke, ktora sa ukaze kliknite na
poloZku Properties > otvori sa okno Hot Spot .

Hotspat x|

Hot Spok: | Size and Position I

—Appearance

Frame color: |:||*| Frame width: ID j
Fill calar: |:||v| Fill Transparency: IlEID j%

Previen

[~ Show hand cursor over "hit" area

St shortouk ke

Current shortcuk: Mone Select kevs. .. |

[~ Apply to all Settings ¥ |
&) Learn more. . (0] 4 I Cancel Apply

Frame color (farba ramcéeka)

Fill color (farba vyplne)

Frame width (hrdbka linky ram&eka) — ak je hrabka nula, tak linka zmizne

Fill Transparency (priehfadnost vyplne) — 100% - vyplf je maximalne priehladna

Correct Answer (spravna odpoved) — ak chcete, aby ramcek hot spot oznacoval
nespravnu odpoved, tak toto polic¢ko musi byt nezaciarknuté
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12.2. Dichotomickd uloha (True/False)

Ponuka Insert > Other Slide(s) > Question Slide > True/False > Graded Question .

. .
True,False Question x|

Cuestion Igptions | Reporting I

rQuestion

Mame: ITrue,l'FaIse

Queskion:

=
=

10 ::Il Wiew quiz preferences. .

Paints:

TANSWEr

@ Select correct answer here

Lo Al I True Add

False Delete |

Type: ITrue,l'FaIse j Mumbering:  |A, B, C... -

&9 Leam more... a4 I Cancel |

Name (meno) — vloZte nazov ulohy alebo nechajte prdzdne

Question (otazka) — text ulohy (otazky)
Points (body) — pocet bodov, ktoré dostane uZivatel za spravne rieSenie

Answers (odpovede) — odpovede
Select correct answer here (tu oznacte spravnu odpoved) — spravnu odpoved vyznacte

kliknutim na maly biely krdzok
True (spravne) — kliknite na text a napiste ,ano" alebo ,spravne*
False (nespravne) — Kkliknite na text a napiSte ,nie* alebo ,nespravne*

V3etky Upravy potvrdte — kliknite na tla€idlo OK.
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12.3. Uloha so stru énou odpove dou
12.3.1. Uloha so stru énou odpove dou (Fill-in-the-blank)

V tomto type Ulohy sa dopifia jedna alebo viac odpoved..
Ponuka Insert > Other Slide(s) > Question Slide > Fill-n-the-blank > Graded Question .

Mew fill-in-the-blank question x|

Question |thi|:|ns I Reparting I

iuestion
Mame: IFilI-in-the-bIank
Description: | SAnEElE  Filling in the blanks,

Painks: |1IZI ill Wi quiz preferences. ..

—Type in the question or phrase that needs to be completed
[~ Shuffle Lisk &nswers [~ Hide Numbering

Phrase: Tvpe the phrase here ;I Add Blark. .. |
Blariks: Edit Blank... |
To enter a <blank> field, select a ward in the phrase

above and click the "Add Blank..." butkon, Delete Blank

i) Lean more. . Ok, I Cancel

Name (meno) — vloZte nazov ulohy alebo nechajte prazdne

Description (popis) — sem napisSte popis — navod, ako ma Ziak rieSit tlohu

Points (body) — pocet bodov, ktoré dostane uZivatel za spravne rieSenie

Shuffle List Answers — mieSanie odpovedi v zozname

Hide Numbering (schovat Cislovanie)

Phrase (fraza) — sem napiste vetu, v ktorej sa niektoré slova skryju a Ziak ich bude dopinat
Blanks — tu sa objavia slova, ktoré budu vynechané vo vete

Vo vete v poli Phrase oznadte slovo, ktoré chcete skryt a potom kliknite na tlacidlo Add
Blank .

—Tvpe in the queskion or phrase that needs to be completed
[~ Shuffle List Answers [~ Hide Murnbering

Phrase: Treba doplnit’ nejalks .

Blanks: Edit: Blark, .. |

To enter a <blank> figld, select 5 word in the phrase
above and click the "add Blank,, " butkan Melete Blapl I
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Otvori sa okno Blank Answer .

Blank Answer |

& Theuser will tvoe in the answer, which wil be comparad to the list belaw

™ The user will select an answer From the list belaw,

slovo Add

Delete

[~ The answer is case-sensitive

&9 Lean more... oK I Cancel |

The user will type in the answer, ... — uzivatel bude spravne odpovede vpisovat
T
™ The user will bype in the answer, which will be compared ta the list below,
& The user will seleck an answer From the fist below,
slova Aadd
Delete
&) Lean more... kK Cancel
The user will select an answer from ... — uZivatel bude spravnu odpoved vyberat zo
Z0znamu

Vtomto pripade treba eSte ku spravnej odpovedi (je zaliarknutd) doplnit niekolko
nespravnych odpovedi. Kliknite na tlagidlo Add a napiSte nespravnu odpoved. Ak chcete
niektort odpoved vymazat, tak najskor na fu kliknite a potom kliknite na tlacidlo Delete.
Zmeny potvrdte — kliknite na tlaidlo OK.

Po navrate do okna New fill-in-the-blank question = mobZete vidiet, Ze oznacené slovo bolo
nahradené Cislicou v Spicatych zatvorkéach.

—Tvpe in the question or phrase that needs to be completed
[~ Shuffle List Answers [~ Hide Mumbering

Phrase: Treba doplnit’ nejaks G,

=] | addElark.., |

Edit Elank. .. |
Delete Blank |

Blanks:

45



Zakladna Skola, Tribe¢ska 1653/22, 955 01 Topol¢any

12.3.2. Uloha so stru énou odpove d'ou (Short answer)

V tomto type Ulohy sa dopifia iba jedna spravna odpoved.
Ponuka Insert > Other Slide(s) > Question Slide > Short answer > Graded Question .

Mew short answer question ﬂ

Question | ptians | Reporting |

uestion
Mame: IShu:urt aNSWer
Cuestion; ;I
[~
Painks: IlEI ﬂ View guiz preferences. ..

—Acceptable Answers

Add

Delete |

[~ The answer is case-sensitive

&9 Leamn more. oK I Cancel

Name (meno) — vloZte nazov ulohy alebo nechajte prazdne

Question (otazka) — text ulohy (otazky)

Points (body) — pocet bodov, ktoré dostane uZivatel za spravne rieSenie

Acceptable Answers — sem napiSte odpoved alebo odpovede, ktoré budu akceptované
ako spravne (kliknite na prazdnu plochu a mézete pisat)

The answer is case-sensitive — ak zaCiarknete toto policko, tak sa budu rozliSovat malé
a velké pismena

Add (pridat) — odpoved mdZete pridat aj tak, Ze kliknete na toto tlacidlo

Delete (odstranit) — kliknite na napisant odpoved a potom kliknite na toto tlaCidlo —
odpoved sa odstrani
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12.4. Prirad’ovacia uloha (Matching)

V tomto type ulohy sa prvky z jednej skupiny prirad'uju ku prvkom v druhej skupine.
Ponuka Insert > Other Slide(s) > Question Slide > Matching > Graded Question .

MNew matching question il

Question |gptiu:|ns | Reporting |

rueskion

Mame: IMatching
Question: voe the question here ;l
=

Puoinks: 10 :II Wigw gquiz preferences. ..

Answers
[~ shuffle Answers

ICqumn 1 Colurin 2

Drag and Drop

from one
column to the
other to create

a match.

Add I [elete |L|LI Match I Add I [elete |LILI

Clear matches |

Style: IDrag Drap j Numbering: I-‘:'u B, j

&) Leain more. . Ok I Cancel |

1, 2 — sem napiSte slova alebo slovné spojenia (kliknite na prdzdne miesto a mézete pisat)
Name (meno) — vloZte nazov Ulohy alebo nechajte prazdne

Question (otazka) — text Ulohy (otazky)

Points (body) — poCet bodov, ktoré dostane uZivatel za spravne rieSenie

Shuffle Answers — ak zacliarknete toto policko, tak pri kazdom otvoreni testu sa odpovede
premiesajq, t.j. povymienaju si pozicie

Column 1, Column 2 — miesto tychto textov napiSte nazvy skupin

Match — spojenie dvojice - kliknite na niektory riadok v pravej skupine, potom na prislusny
riadok v druhej skupine a nakoniec na tla€idlo Match

Un-Match —rozdelenie spojenej dvojice - oznacte dvojicu a kliknite na tlacidlo Un-Match
Numbering (Cislovanie)
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12.5. Usporiadacia Uloha (Sequence)

V tomto type Ulohy treba spravne usporiadat’ nejaké pojmy, napr. Cisla od najmensSieho po
najvacsie.
Ponuka Insert > Other Slide(s) > Question Slide > Sequence > Graded Question .

Sequence Question x|

Question |thiu:uns I Reporting I

oueskion
Marme: ISequence
Question: | Y d
I~
Painks: Ilﬂ—j ‘Wiew quiz preferences. ..
AnsWers

<9 Enter the Answers in correct order

(T

dd

Delete

Mave g

Mave Do

s

Styles IDrag Drop j Mumbering: I'C‘J B, ... vl

&) Lean more... oK I Cancel

1 — sem napiSte pojmy v spravnom poradi

Name (meno) — vloZte nazov Ulohy alebo nechajte prazdne

Question (otazka) — text ulohy (otdzky) — navod pre Ziakov, ¢o treba urobit
Points (body) — poCet bodov, ktoré dostane uzivatel za spravne rieSenie
Numbering (Cislovanie)

Move Up (posunut hore) — oznaceny pojem posunie o jednu poziciu vySSie
Move Down (posunut dole) — ozna¢eny pojem posunie o jednu poziciu nizSie

Priklad vloZenych pojmov (Cisla usporiadané od najmenSieho po najvacsie):

FAnswWers

<9 Enter the Answers in correct order

a)l
b2
13 Delete
di 4
e)5

Move Up

il
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12.6. Vzhlad snimky s ulohou

X | dERQueston. | o x| &) % B =
Nadpis Correct - Click
: anywhere or press
Uloha. Y to continue
= a)odpoved 1 ' Incorrect - Click

anywhere or press

| b) edpoved 2 _“__'y' to continue |
—H X You must answer
_.: ¢) odpaved 3 the question before

cantinuing

d) odpoved 4

w10 11 12 13
=
Skip

|I:> Question 2 of 2 Clear Back Submit

1 — ak chcete Ulohu opravit tak kliknite na tlacidlo Edit Question
2 — nazov ulohy

3 — text ulohy

4 — odpovede

5 — hlasenie pri spravnej odpovedi

6 — hlasenie pri nespravnej odpovedi

7 — hlasenie pri nekompletnosti

8 — vtejto Casti sa po skon&eni testu ukdze hodnotenie — Ci bola Uloha spravne alebo
nespravne vyriedena

9 — poradoveé Cislo otazky z celkového poctu otdzok

10 - tlacidlo vymazat’ (vydistit)

11 - tlacidlo spat

12 — tlacidlo preskocit

13 —tlacidlo odoslat’ — potvrdit
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13. Objekty
13.1. Textovy blok (Text Caption)

Ponuka Insert > Standard Objects > Text Caption .

New Text Caption x|

Texk Caption |Options I Audio | Size and Fosition |

Zaption type: Font: Size:

Ihalogreen Jl.ﬂrial JI22 J_Iab‘f;lﬂl
4

= Bru|EESE[ZEEE Q==

ne caption text here

]
i
o
II

3

I~ apply o 4l Settings = | Accassibiliy |
& Leam more... OF | Cancel | apply |

Karta Text Caption

1 — vzhlad bloku

2 — farba pisma

3 — podfarbenie pisma

4 — rbzne nastavenia textu

5 — sem sa piSe text

Caption type — typ bloku

Caption type - transparent — priehladny blok bez ramc&eka
Font — font pisma

Size — velkost pisma
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MNew Text Caption ﬂ
Text Caption  OPtions | audio | Size and Position |
ame
Item Mame: aptionlten3 [v Visible
—Tirning
Displaw For: Ispecific time j IB,D j' seconds

Appear after: 0,0 j seconds

—Transitiar
EFfect: IFade in and aut j

In: |0,5 :|I seconds Ot IU,5 ﬂsecnnds

[ Apply ko all Settings + | accessibility |
&) Learn more. [8]4 I Cancel | Apply |

Karta Options

Display for — specific time - zobrazi sa na urCity ¢as (v sekundach)

Display for —rest of slide — zobrazi sa pocas zobrazenia snimky

Display for —rest of project — zobrazi sa pocas celého projektu

Appear after (zobrazi sa po) — po kolkych sekundach od zaciatku snimky sa zobrazi
Effect — Fade in and out — rozjasnenie na zaciatku a stmavenie na konci

Effect — Fade in only — iba rozjasnenie

Effect — Fade out only — iba stmavenie

Effect — No transition - Ziadny efekt

In — kofko bude trvat’ rozjasnenie (v sekundach)

Out — kofko bude trvat’ stmavenie (v sekundach)

Zmena vlastnosti (nastaveni) oznaovacieho rdmceka:

1. Rdmcek oznacte (kliknite nar) > kliknite na tladidlo Properties (1) (tlacidlo sa nachadza
v liSte s editaénymi nastrojmi, ktoré je hned nad snimkou) > otvori sa okno Text Caption ,
v ktorom mdZete upravit’ nastavenia aj zmenit text.

2. Kliknite pravym tlagidlom mySi na oznaCovaci ramcéek a ponuke, ktora sa ukaze, kliknite
na polozku Properties . Otvori sa okno Text Caption .

Dlaﬁnh:@
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13.2. Oznacovaci ram éek (Highlight Box)

Ponuka Insert > Standard Objects > HighLight Box .

Oznacovaci rAmcek slizi na oznacenie niektorého miesta alebo objektu v snimke.

Ak chcete zmenit vlastnosti (nastavenia) oznacovacieho ramceka, tak najskér ramcek
oznacte (kliknite nan) a potom kliknite na tlaCidlo Properties (1). Tlacidlo sa nachadza
v liste s editaCnymi nastrojmi, ktora je hned nad snimkou.

Druhy spbsob je, Ze kliknete pravym tladidlom mysSi na oznaCovaci ramc€ek av ponuke,
ktora sa ukaze, kliknete na polozku Properties .

e |40 x0T e o

Otvori sa okno Highlight Box .

i

I Options I Audio I Size: and Position I

TAppEarance

Frame color: | Frame width: 1 =
Fill colar: 1] |v| Fill transparency: IBU ﬂ a4

[~ Fill uter area

rPreview

[~ apply ko all Settings + |
a Learn more.... oK I Cancel Apply

Frame color (farba ramcéeka)

Fill color (farba vyplne)

Frame width (hrubka linky rdmceka) — ak je hrubka nula, tak linka zmizne

Fill Transparency (priehladnost vyplne) — 100% - vyplrfi je maximélne priehfadna
Fill outer area (vyplnit vonkajSiu oblast) — vyfarbi sa oblast zvonku ramc¢eka
Preview (nahlad)
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13.3. Rolovaci blok (Rollover Caption)

Ponuka Insert > Standard Objects > Rollover Caption .

Rolovaci blok sa sklada z dvoch Casti — z aktivnej oblasti (1) a z textového bloku (2).
Aktivna oblast sa m6ze umiestnit na niektory objekt v snimke. Po prejdeni mySou na
aktivnu oblast sa objavi textovy blok.

Uprava vlastnosti textového bloku — obdobne ako Text Caption .

Uprava vlastnosti aktivnej oblasti — obdobne ako HighLight Box .

e -, Rodoer frea
| Tea | oo ) < 1

13.4. Rolovaci obrdzok (Rollover Image)

Ponuka Insert > Standard Objects > Rollover Image > vyhladat obrazok v pocitaci >
otvorit obrazok.

Rolovaci obrdzok sa sklada z dvoch Casti — z aktivnej oblasti (1) a z obrazka (2). Aktivha
oblast sa m6ze umiestnit' na niektory objekt v snimke. Po prejdeni mySou na aktivnu oblast
sa objavi obrazok.

Uprava vlastnosti obrazka — obdobne ako Image.

Uprava vlastnosti aktivnej oblasti — obdobne ako HighLight Box .

13.5. Rolovacia snimka (Rollover Slidelet)

Ponuka Insert > Standard Projects > Rollover Slidelet .

Rolovacia snimka sa sklada z dvoch €asti — z aktivnej oblasti (1) a zo snimky (2). Aktivha
oblast sa méze umiestnit' na niektory objekt v snimke. Po prejdeni mySou na aktivnu oblast
sa objavi rolovacia snimka.

Do rolovacej snimky mdZete vkladat vSetky objekty, napr. texty, obrazky, zvuky, video,
okrem testovych Gloh — kliknite na rolovaciu snimku (2) pravym tlagidlom mysi, v ponuke,
ktora sa ukéze kliknite na polozku Insert a vyberte objekt, ktory chcete vloZit.
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13.6. ZvaéSovacia z6na (Zoom Area)

Ponuka Insert > Standard Objects > Zoom Area .

Zvacsovacia zéna sa sklada z dvoch Casti — z aktivnej oblasti — Zoom Area (1) azo
zobrazovacej oblasti — Zoom Destination Area (2). Aktivnu oblast umiestnite na tu Cast
snimky, ktord chcete zvacsit. Zvaésenina sa ukaze v zobrazovacej oblasti.

Uprava vlastnosti zvac3ovacej zony — obdobne ako HighLight Box

Trsin Draitinaslion Arga
(125 2 128} 2
[aa2; 2103)

13.7. Textové pole na vstup (Text Entry Box)

Ponuka Insert > Standard Objects > Text Entry Box .
Textové pole na vstup sa da vyuZzit napr. na zaliatku projektu. Iba uZivatel, ktory pozna
heslo a spravne ho napiSe do pola sa dostane dale;j.

Mew Text Entry Box ﬂ

| Options I Audio I Reporting I Size and Position I Advanced I

—Sekking
Default bext: I v Retain Text

I the user enters the text correctly

Carrecht entries: Font... |

#Add

DE|eke |

0N success: Continue ;I

—IF the user enters the text incorrectly

Allow user: |1 ill atternpts or v Infinite attempts

After last attempt: I Continue ;I

r5et shorkout key

Zurrent shorkcuk: Enter Select keys... |

™ Apply to &l Settings | Accessibility |
&) Leain more... oK I Cancel | Apply |
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Karta Text Entry Box

Default text (zékladny text) — tento text bude zobrazeny v poli

If the user enters the text correctly  (ak uZivatel vloZi spravny text)

Correct entries — odpovede, ktoré budu prijaté ako spravne

On success — akcia, ktora sa vykona pri vlioZeni spravneho textu

If the user enters the text incorrectly  (ak uZivatel nevloZi spravny text)

Allow user 1 attempts or Infinite attempts (povolit uzivatefovi jeden pokus alebo
nekonecne vela pokusov) — tu mdZete nastavit jeden, niekolko alebo nekone¢ne vela
pokusov na vioZenie textu

After last attempt (po poslednom pokuse) — akcia, ktora sa vykona po poslednom
neuspesnom pokuse

Text Entry Box ﬂ
Texk Entry Box Audio I Reporting I Size and Position I Advanced I
rMame
Tkem Mame: ITTextEntryIteml v Visible
—Tirnirg
Lisplay for: Ispeciﬁc Lime j |3,U j seConds
Appear after: 0,0 j seconds
Pause after: 1,5 ill seconds
r—Transition
Effect: IFade in and out j
In: IDJS ill seconds gk IDJS jl seconds
Appeatance
Transparency: ID ill% Background color: D |'|
—Opkion
[ Walidate user input [ Show butkon
[V Success caption [ Show text boce Frame
[ Eailure caption [~ Password
[v Hint caption [~ Case-sensitive
[V Pause for success|failure captions I~ show Serollbar
[~ Apply to al Sethings + | Accessibility |
ﬂ Learn more... QK I Cancel | Apply |

Karta Options

Display for — specific time - zobrazi sa na urCity ¢as (v sekundach)

Display for —rest of slide — zobrazi sa po¢as zobrazenia snimky

Display for —rest of project — zobrazi sa pocas celého projektu

Appear after (zobrazi sa po) — po kolkych sekundach od zaciatku snimky sa zobrazi
Pause after (pauza po) — po kolkych sekundéch sa projekt pozastavi

Effect — Fade in and out - rozjasnenie na zaciatku a stmavenie na konci

Effect — Fade in only — iba rozjasnenie

Effect — Fade out only —iba stmavenie

Effect — No transition - Ziadny efekt
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In — kofko bude trvat’ rozjasnenie (v sekundach)

Out — kofko bude trvat stmavenie (v sekundéach)

Transparency (priehladnost)

Background color (farba pozadia)

Validate user input - overovat text

Succes caption — hlasenie pri zadani spravneho textu

Failure caption — hlasenie pri zadani nespravneho textu

Hint caption — zobrazit pomocny text (uk&zZe sa, ak uZivatel prejde ukazovatelom mysi na
textové pole)

Show button (ukazat tlacidlo)

Show text box frame (ukazat rdmcek okolo textového pola)

Password (heslo) — ak zadiarknete toto poli¢ko, tak v textovom poli sa pri pisani textu budu
zobrazovat iba hviezdi¢ky, a nie pismena

Case-sensitive — rozliSovat malé a velké pismena

Objekt textoveé pole na vstup (Text Entry Box ) po vioZeni do snimky vyzer takto:

-

1

Type success
text here
Type failure text «-
here |
Type hint text here h
1 — textové pole

2 — potvrdzovacie tlacidlo

3 — hlasenie pri zadani spravneho textu

4 — hlasenie pri zadani nespravneho textu

5 — pomocny text — ukdzZe sa, ked uzivatel prejde ukazovatefom my3i na textové pole
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13.8. Klikacia zéna (Click Box)

Ponuka Insert > Standard Objects > Click Box .
Klikacia z6na je vlastne neviditelny ramcek, ktory mézete umiestnit’ hocikde do snimky a po
kliknuti nan sa vykona uréend akcia.

New Click Box x|

lick Bax IOptiDns | Audio | Reporting | Size and Position |

rIF the user clicks inside the click bo

On success: |y

[~ Disable Click Sound

rIF the user clicks outside the dlick bo
Allows user: |1 ill atkempts or [ Infinite akternpks

After last atternpt: | Continue =]

—Set shortout key

Current shartcut: — Mane Select kews. .. |

™ Apply to all Settings + | Accessibility |
a Leamn mare... Ok I Cancel | Apply |

Karta Click Box

If the user clicks inside the click box  (ak uzivatel klikne na klikaciu z6nu)

On success — v tomto poli mbZete vybrat akciu, ktora sa vykoné po spravnom kliknuti
Disable Click Sound (vypnut zvuk kliknutia)

If the user clicks outside the click box (ak uzivatel klikne mimo klikacej zény)

Allow user 1 attempts or Infinite attempts (povolit uzivatefovi jeden pokus alebo
nekonecne vela pokusov) — tu mbéZete nastavit jeden, niekolko alebo nekoneéne vela
pokusov na kliknutie

After last attempt (po poslednom pokuse) — akcia, ktora sa vykona po poslednom
neuspesSnom pokuse
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New Click Box |
Click Box ~ ©pkions I.ﬂudio I Reparting I Size: and Pasition I

TMarme
Tkern Marme: [ wisible

—Timing
Display For: Ispeclﬂc time j IS,EI = seconds
Appear after: IIZI,D j seconds

iopkions
[v Success capkion v Pause project until user clicks
v Eailure caption [ Double mouse click
[ Hink caption [ Right mouse click.
[~ Show hand cursar over "hit" area ¥ Pause for success/Failure captions

[~ Apply ko Al Setkings = | Bccessibility |
ﬁ Leain more... QK I Cancel | Apply |

Karta Options

Display for — specific time — zobrazi sa na urcity ¢as (v sekundach)

Display for —rest of slide — zobrazi sa pocas zobrazenia snimky

Display for —rest of project — zobrazi sa pocas celého projektu

Appear after (zobrazi sa po) — po kolkych sekundach od zaciatku snimky sa zobrazi
Succes caption — hlasenie pri zadani spravneho textu

Failure caption — hlasenie pri zadani nespravneho textu

Hint caption — zobrazit pomocny text (uk&zZe sa, ak uZivatel prejde ukazovatelom mysi na
textové pole)

Show hand cursor over ,hit“ area  (po prejdeni na klikaciu zénu zobrazit ukazovatel mysi
ako ruku)

Pause project until user clicks  (pozastavit projekt az kym uzivatel neklikne)

Double mouse click — poZadovat dvoijité kliknutie mySou

Right mouse click — poZadovat kliknutie pravym tlacidlom mys3i
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13.9. Tlagidlo (Button)

Ponuka Insert > Standard Objects > Button .
Do snimok méZete vkladat tlacidla, ktoré zabezpecia napr. posun na nasledujucu snimku
alebo skok o niekolko snimok napred, ¢i dozadu.

Mew Button ﬂ

Buttan |Opti0ns I Audio I Reporting I Size and Position I

Buttan bype
Type: IImage button j

| Current button skyle (75x25) j _l
AN

[~ Transparent buktons

1

r—If the user clicks on the buttan

On success: |y

[~ Disable Click Sound

i~ IF the user clicks outside the button
Allovy user: |1 ill attempts or  [v Infinite attempts

After last atkempt: | Continue =]

—Set shorbout ke

Current shorkouk: Mone Select keys., .. |

[ Apply to al Sethings | Accessibility |
&) Lean mare. . Ok, I Cancel | Apply |

Karta Button

Type (typ tlac¢idla) — Text button , Transparent button , Image button

Image Button (grafické tlacidlo)

1 — v tomto poli si vyberte vzhlad tlacidla

Transparents button (priehladné tlacidla)

If the user clicks on the button  (ak uzivatel klikne na tlacidlo)

On success — Vv tomto poli mdZete vybrat akciu, ktora sa vykona po kliknuti na tlacidlo
Disable Click Sound (vypnut zvuk Kkliknutia)

If the user clicks outside the button  (ak uzivatel klikne mimo tlacidla)

Allow user 1 attempts or Infinite attempts (povolit uzivatefovi jeden pokus alebo
nekonecne vela pokusov) — tu mdZete nastavit jeden, niekolko alebo nekone¢ne vela
pokusov na kliknutie na tlacidlo
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utkon bype

Type: ext button

Eutton text: IButton Fant... |

[~ Transparent

Text button (tlacidlo s textom)
Button text (text na tlacidle)
Transparent (priehlfadny)
Font — nastavuje sa font pisma

utbon Eype

Type: ransparent butkon

Frame color: 1 |*| Frame: width: II j
Fill calor: 1 |v| Fill transparency: IU ::ll %o

Transparent button (priehfadné tlacidlo)
Frame color (farba linky)

Fill color (farba vyplne)

Frame width (hrubka linky)

Fill transparency (priehfadnost’ vypine)

New Button il
Butbon  Cptions |P.udic- | rReparting | Size and Position |
Mame
Item Marme: ButtonltemzZ [ Visible
—Tirnirg
Display Far: Ispecific tirne j IS,D j seconds
&ppear after: IUJU j seconds
v Pause after: 1,5 :II seconds
ioption:
[~ Success caption [~ Double mouse click
[~ Failure caption [~ Show hand mouse cursar when over butkon
[ Hint caption ¥ | Pause for success|failure captions
Karta Options

Display for — specific time - zobrazi sa na urCity ¢as (v sekundach)

Display for —rest of slide — zobrazi sa po¢as zobrazenia snimky

Display for —rest of project — zobrazi sa poc€as celého projektu

Appear after (zobrazi sa po) — po kolkych sekundach od zaciatku snimky sa zobrazi

Pause after (pauza po) — po kolkych sekundéach sa projekt pozastavi

Succes caption — hlasenie pri zadani spravneho textu

Failure caption — hlasenie pri zadani nespravneho textu

Hint caption — zobrazit pomocny text (uk&zZe sa, ak uZivatel prejde ukazovatelom mysi na
textoveé pole) kontrola pozornosti — zavolajte mi na modj mobil, ak objavite tito vetu

Double mouse click — poZadovat dvoijité kliknutie mySou
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14. Kreslenie
14.1. Ciara (Line)

Ponuka Insert > Drawing Objects > Line.
Do snimky sa daju vkladat Ciary, ktoré mézu byt zakon&ené napr. Sipkou alebo guléckou.

X

TAppearance
Line color: [ |v| Skroke width: |1 ill
Skroke skyle: m Transparency: I':'_jl %
Stark: Im End: IN:::ne 'I
Preview
[~ Apply ko all Settings
a Learn mare. .. (] 4 Zancel Al

Line color (farba Ciary)

Stroke style (Styl iary)

Start (zaciatok) — vyberte zaciatok Ciary
Stroke width (hrubka Ciary)
Transparency (priehladnost)

End (koniec) — vyberte koniec &iary
Preview (nahlad)
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14.2. Stvoruholnik (Rectangle)

Ponuka Insert > Drawing Objects > Rectangle .

|Optiu:uns I Audio I Size and Position I

Rectangle x|

TAppEarance
stroke color: [ |*| Stroke width: |1_ﬂ
Fill color: |:||*| Fill transparency: In_ﬂ o
Stroke style: |5'2'|i'2| j Cornet radius: In_ill o,
Preview
[~ Apply ko all Setkings = Accessibility |
a Learn more. .. (] 4 Zancel Al |

Stroke color (farba Ciary)

Fill color (farba vyplne)

Stroke style (Styl Ciary)

Stroke width (hrubka Ciary)

Fill transparency (priehladnost vypline)
Corner radius (zaoblenie rohov)
Preview (nahlad)
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14.3. Elipsa, kruh (Oval)

Ponuka Insert > Drawing Objects > Rectangle .

oval x|

| Options I Audio I Size: and Position I

TAppEarance

Strake colar: -|*| Skroke width: |1 ill
Fill color: |:||*| Fill transparency: ||:| ﬂ%

Stroke style: |5'2'|i'2| j

Preview

™ Apply ko &l Settings = ficcessibility |

a Learn more. .. (] 4 Zancel Al |

Stroke color (farba Ciary)

Fill color (farba vyplne)

Stroke style (Styl iary)

Stroke width (hrubka Ciary)

Fill transparency (priehfadnost’ vyplne)
Preview (nahlad)
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Ponuka Insert > Drawing Objects > Polygon .

14.4. Viacuholnik (Polygon)

FreeForm Polygon

| COpkions I Audio I Size and Position I

TAppearance
Stroke color: |v| Stroke width: |1_ﬂ
Fill calor: [ |*| Fill transparency: IEI_iII %a
Stroke skyle: |5.;.|i.;| vI
Preview
[~ Apply ko all Setkings = Accessibility |
ﬂ Learn mare. .. (] 4 Zancel Bl |

Stroke color (farba Ciary)
Fill color (farba vyplne)
Stroke style (Styl Ciary)
Stroke width (hrubka Ciary)

Fill transparency (priehladnost vypline)

Preview (nahlad)
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15. Animovany text (Text Animation)

Ponuka Insert > Text Animation .
Animovany text sa pohybuje az vo vyslednej animacii.

MNew Text Animation ﬂ

Text Animation |0ptions I Audio I Size and Position I

AppEear ance
Effect:

Aquariurnm e

Texk:

Sample Text
Sa mplet%(l

Change font. ., |
Transparency: ID j o
1 Delay (Frames): |1 ﬂ

[~ Apply ko al Settings | ficcessibility |
ﬂ Learn more... O I Cancel | Apply |

/

1 — v tejto Casti sa zobrazuje nahlad textu

Effect (efekt) - tu si mbézZete vybrat z mnoZstva r6znych animacii

Text — do tohto pola vpiSte text, ktory sa mé animovat (kliknite do pola a piste)
Change font — zmenit font pisma

Transparency (priehladnost)

Delay (oneskorenie)
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16. Obrazok (Image)

Ponuka Insert > Image — vyhladat v pocitaci obrdzok — kliknat na tlacidlo Otvori t.

Uprava obrazku:

- pravym tlacidlom mysi kliknite na obrazok a v ponuke, ktora sa ukaze, kliknite na polozku
Properties (vlastnosti)

Otvori sa okno Image (obrazok).

x|
' | Options I Audic | Size: and Position I
—Appearance
Transparency: I-El_ﬂ Y [~ Transparent backoround [ |—|
Previgw

Reset ta original si;el Select image From brary... | Import... | Zrop |

[~ Apply to all Settings + | Accessibility |
e Learm more... Ok I Cancel | Apply |

Transparency (priehladnost)

Transparent background (priehlfadnost pozadia obrazka)
Reset to original size (vratit na pévodnu velkost)

Select image from library  (vybrat obrazok z kniznice)
Import - vilozZit obrazky z prie€inka v pocitaci

Crop (orezat) — vyrezanie urcitej Casti obrazka
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Po kliknuti na tla¢idlo Crop v okne vlastnosti obrazka (Image) sa otvori okno Resize/Crop
Image (zmenit velkost/orezat’ obrazok).

Plochu, ktor4 sa ma zachovat nastavite tak, Ze uchopite niektory zo sivych Stvoréekov na
okraji &erveného bodkovaného obdiznika a potiahnutim zmenite jeho velkost. Cast
obrazka, ktora bude mimo &erveného bodkovaného obdiZnika sa po kliknuti na tlagidlo OK
odreze.

Resize/Crop Image 1] E'

€ Fi 1o Stage & -Ciop Zoom: | | |Ee=t Fit v|
¥ Constran proportions  Image Size: 382 % 287 | Crop Area: 382 x 287 oK | Cancel I

Fit to Stage (roztiahnut na plochu)

Crop (orezat)

Zoom - lupa, obrazok si m6zete priblizit' alebo oddialit’

Constrain proportions — ak je zaSkrtnuté toto poli¢ko, tak pri zmene jedného rozmeru
obrazka sa bude proporéne menit aj druhy rozmer

Image size — velkost obrazka v pixeloch

Crop Area — velkost orezavacieho &erveného obdiZnika v pixeloch

Po vykonani vSetkych zmien kliknite na tlaidlo OK.
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Obrazok, ktory je vloZzeny do snimky, mbzZete eSte upravit — nastavit jas, kontrast a pod.
Kliknite pravym tlac¢idlom mysi na obrazok. Uk&Ze sa ponuka, v ktorej kliknite na polozku
Image Edit (upravit obrazok).

Vedla plochy snimky vpravo sa otvori panel Image Edit .

Je tu niekolko pésikov, pomocou ktorych sa nastavuje vzhlad obrdzka. Staci, ked uchopite
.bezec" na pasiku a posuniete ho dolava alebo doprava. TaktieZ méZete nastavit' Ciselnu
hodnotu v poli¢ku vedla pasika. VSetky zmeny sa hned prejavia na obrazku.

Panel Image Edit sa zavrie, ak kliknete na kriZik v hlavicke panelu.

T 3F TR | NERCRECeNd T Prevaew = Pucker. [Tl send Tor e | el edo, TR e TTESE W ]
x| Baderoperten.. | UE) niee) wiei ] WET] & zeomcfen || v Image Edk x
I . 1 b
A
: Shanpress:
: : : —
Conirask:
L I o
Trarsparency:
1 P
Hue:
r .\ b
Saturation
| ] 1 -
B Hosak:
: 1 b
H [ Grary Scals ™ vt Colors
| Fig; Al
‘| [ af] rome  BlEow  H
i || = Timeline for Slide 4 =
I g Lo E:I ;: & slk Ry o gl,; % I?s :r'_"l Fropesties... | frasnt ol |
I I |t FEFEL TN T eI FRETL T g We i pFecp o e Thanh bk Wi ya s Wa ki fach ol e da Ak
- 4 lsbskyipation |2 .

Brightness (jas)

Contrast (kontrast)
Transparency (priehladnost)
Hue (odtier)

Saturation (sytost)

Mosaic (mozaika)

Gray Scale (siva skala)
Invert Colors (prehodit farby)
Flip (preklopit)

Rotate (otocenie)

Crop (orezat)

Properties (vlastnosti)
Reset all (zrusSit vSetky zmeny)
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17. Flash Video

Ponuka Insert > Flash Video .

Flash video je Specialny komprimovany format videa s koncovkou *.flv. Klasické video
s koncovkou *.avi alebo *.mpg treba preto skonvertovat. Na konverziu mézete pouzit napr.
program Super.

Mew Flash Yideo x|

I Options I Audia I Position I

Video tvpe: IPragressive Download Video j

File Link: I Browse... |

(Enter the relative or absolute path of the Flash Yideo file)

Skin: ICIear Skin 1 {min width: 1400 j

> o3

Wwidth: I ¥ Comstrain  Detect Size |
Height: I Total with skin:

[~ Auto play
[~ Auka rewind

[~ Apply ko all Settings # | Accessibility |
a Learn mare.... Ik I Cancel | Apply |

File Link — odkaz na subor — video

Browse (hfadat) — kliknite na toto tlacidlo a vyhladajte video v pocitaci

Skin — vzhlad ovladacich tlacidiel

Width (Sirka)

Height (vySka)

Constrain — ak je zaciarknuté toto tlacidlo, tak Sirka a vySka sa menia v presnom pomere
Auto play - za¢ne sa automaticky prehravat

Auto rewind — automatické pretoCenie
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18. Skin Editor

Ponuka Project > Skin Editor .

ke [ My Current Shin =]  saess. |  peles |
Playback Contrel | Borders | TOC |

B S playback cortrol i

Playbar | default =l

ok | 0| S |

Layout:  |Sretched B |

¥ play[Pause I+ Back

W Revarad v ClosefExk

W Eorward = bute

[T Closed Caphioning [ Progresshar

I I~ Fast Foreard

Trarsparency: [D_':Ij%

T Playback Colees

8 - T oy I .I
L_IE|
—
LIS

ﬁmmum

b Leain meee. | | o I

Skin — v tomto poli si méZete vybrat z prednastavenych vzhladov
Save as — zapamatat aktualny (upraveny) vzhlad
Delete — vymazat oznaceny vzhlad zo zoznamu

Karta Playback Control

Show playback control (ukazat ovladanie prehravania)
Playbar — tu si mézete vybrat vzhlad liSty s ovladacimi tlaCidlami
Position — pozicia listy

Layout — rozmiestnenie tlacidiel

Play/Pause (spustit/pauza)

Rewind (pretocit)

Forward (vpred)

Back (spat)

Close/Exit (zatvorit/ukongit)

Mute — vypnutie zvuku

Progressbar (ukazovatel pozicie)

Fast forward (rychlo vpred)

Transparency (priehladnost)

Playback Colors - farba listy a tlacidiel

1 — panel s ovladacimi tlacidlami
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Mstanedror
sin: | My Curment Skin T

Playback Control  Borders |Toc |
I Shews Borders:

sarders (1| 55| ) O

Ii'hu:l B pdgs _'_I
¥

Traiure IH:.ng
Wi 31 j
Coiar == -.I

Y 1
RSl U il Ll Ll Ca il ooy

=10l

O Lean nore | [ o |

Karta Borders

Show Borders (zobrazit okraje)

Border (okraj)

Style (5tyl)

Texture (textura)

Width (hrabka)

Color (farba)

HTML backgroung color — farba pozadia v HTML
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Vo vyslednej animacii mbZete zobrazit obsah — odkazy na jednotlivé snimky.

B2 skin Editor* =] |
Sk [ty Current Skin (Modied) =] sweds. ] [ty J

Playback Control | Borders T0C |
[+ Showe T

Take

I Shda 1
She 2
Shde 3
Shde 4
Shia 5
Sida 7
Shde 8

el il sl <e
-'\.\'-"'\-I'.J"-"-".-v“l"'ﬂ'—?

1 =, e ) [

settogs... | o, |

0 Loammoss o | carcel |

Karta TOC (Table of Contents)

Table of Contents (obsah)

Show TOC (zobrazit obsah)

Title — v tomto poli mézete vybrat’ snimky, ktoré sa zobrazia v obsahu
Settings (nastavenie)

1 — takto sa zobrazi obsah vo vyslednej animacii

19. Kopirovanie objektov (Copy, Paste)

Objekty (textové bloky, obrazky, ramceky, tla€idla a pod.) mbéZete kopirovat a nasledne
vlozZit do konkrétnej snimky viacerymi spésobmi:

1. Kliknite na objekt, ktory chcete kopirovat — stlacte Ctrl+C — kliknite na snimku, do ktorej
chcete objekt vloZit — stlacte Ctrl+V .

2. Pravym tlac¢idlom mysSi kliknite na objekt — v ponuke, ktora sa ukaze, kliknite na polozku
Copy - pravym tlacidlom mysi kliknite v snimke na prazdne miesto — v ponuke, ktora sa
ukéze kliknite na polozku Paste object .

3. Kliknite na objekt, ktory chcete kopirovat — v ponuke Edit kliknite na polozku Copy —
kliknite na snimku, do ktorej chcete objekt vioZit — v ponuke Edit kliknite na poloZzku Paste
object .
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20. Uprava vlastnosti objektov

Objekt v konkrétnej snimke treba niekedy menit — napr. text vtextovom bloku, farbu
oznacovacieho ramceka, vzhlad tlacidla, atd.

V podstate su dva velmi rychle spbésoby, ako otvorit prislusné okno s nastaveniami
konkrétnych objektov.

1. Pravym tlacidlom mys3i kliknite na objekt a v ponuke, ktord sa ukaze, kliknite na polozku
Properties (vlastnosti) (1).

gh Cut Chrl4%
Copy Zhrl+C
| Paste Chel+y
D Cuplicate Chrl+D
X Delete Del
Select Al Chrl+A
Lack, ChrH-alt+k
Hide Ckrl+alk+H
align »
Order L4
£E Sync with Playhead Chrl+L
‘—El Show For rest of Slide  CErl4E
= Increase Indent Chrl+I
= Decrease Indent  Shift+Cerl+1
Audio 3
Propetties. ., C]II

2. Kliknite najskér na objekt a potom Kliknite na tlaCidlo Properties (vlastnosti) (2), ktoré je
na liste nad snimkou.

u .......... SN P — il
r /
[ |_| ................. |
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